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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This document is protected under copyright law. An authorized licensee of Interplay Assist may reproduce this publication for the 
licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for 
commercial purposes, such as selling copies of this document or providing support or educational services to others. This document 
is supplied as a guide for Interplay products. Reasonable care has been taken in preparing the information it contains. However, this 
document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept 
responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change without 
notice.

Copyright © 2014 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER 
RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

http://www.avid.com/US/about-avid/legal-notices/patent-marking
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Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be covered 
by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other 
patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.
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The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid 
Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 002, Digi 003, 
DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, Digital 
Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, Do More, DPP-1, D-Show, DSP 
Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, 
HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID, HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image 
Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, InGame, Instantwrite, Instinct, Intelligent Content 
Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX, 
Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23, iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link & 
Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, 
MassivePack, Massive Pack Pro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media 
Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch, 
NewsCutter, NewsView, NewsVision, Nitris, NL3D, NLP,  NSDOS, NSWIN,  OMF, OMF Interchange, OMM, OnDVD, Open Media 
Framework, Open Media Management,  Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, 
ProControl, ProEncode, Profiler, Pro Tools, Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, 
SecureProductionEnvironment, Serv|GT, Serv|LT,  Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude 
Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, 
SteadyGlide, Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC 
HD, SYNC I/O, Synchronic, SynchroScope,  Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL 
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, 
tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, VideoRAID, 
VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.

Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 

http://www.apache.org/
http://jcifs.samba.org/
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Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

News material provided by WFTV Television Inc.

Interplay | Production Software Installation and Configuration Guide • 0130-07635-04 Rev M • Created 12/15/14

http://www.wildlifeworlds.com
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Using This Guide

Congratulations on your purchase of Interplay® | Production, a powerful system for managing 
media in a shared storage environment. This guide contains overview installation instructions 
and configuration information for the Interplay components on the Interplay Production client 
and server installers.

This guide is intended for all Interplay Production administrators who are responsible for 
installing, configuring and maintaining an Interplay | Production Engine or 
Interplay | Production Archive Engine (database, server, and all related client connections and 
user rights) in an Interplay workgroup. 

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows 
only), (Macintosh), or 
(Macintosh only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.
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If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published. You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes available. To view 
these online versions, select ReadMe from the Help menu, or visit the Knowledge Base at 
www.avid.com/support.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/support. Online services are available 24 
hours per day, 7 days per week. Search this online Knowledge Base to find answers, to view 
error messages, to access troubleshooting tips, to download updates, and to read or join 
online message-board discussions.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.

 | (pipe character) The pipe character is used in some Avid product names, such as 
Interplay | Production. In this document, the pipe is used in product 
names when they are in headings or at their first use in text.

Symbol or Convention Meaning or Action

http://www.avid.com/support
http://www.avid.com/support
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Interplay Documentation

The following documents describe how to use Interplay Production:

• Interplay | Production Best Practices — provides an overview of the major Interplay 
components, shows sample configuration diagrams, and describes several of the key 
features, such as setting up a user database and using the Interplay Archive Engine.

• Interplay | Production Software Installation and Configuration Guide — describes how to 
use the Interplay Production installation programs to install and configure software on the 
various systems that make up a Interplay environment. 

• Interplay | Engine Failover Guide — describes how to set up a cluster configuration for the 
Interplay Engine and the Interplay Archive engine. There are two versions of this guide: one 
for SR2500 systems and one for AS3000 systems.

• Interplay | Engine and Interplay | Archive Engine Administration Guide — describes how to 
administer your Interplay Engine or Interplay Archive Engine and Interplay Production 
database.

• Interplay | Access User’s Guide — describes how to use Interplay Access to browse, search, 
and work with assets in the Interplay Production database.

• Interplay | Assist User’s Guide — describes how to use Interplay Assist for logging, 
archiving, and sending to Playback material in an Interplay environment.

• Avid Instinct User’s Guide — describes how to use the Avid Instinct application to write 
iNEWS stories and put together simple audio and video sequences.

• Interplay | Media Services Setup and User’s Guide — Interplay Media Services lets you 
control and automate Transcode, Archive, and other Interplay Media Services.

• Interplay | Transfer Setup and User’s Guide — describes how to use Interplay Transfer to 
transfer media to and from another workgroup, send finished sequences to a configured 
playback device, ingest media from a configured ingest device, and perform standalone 
transfers between workstations.

• Avid Service Framework User’s Guide — describes how to use the logging, monitoring, and 
management features of the Avid Service Framework applications.

• Interplay | Capture User’s Guide — describes how to use Interplay Capture, a newsroom 
ingest tool that enables automated recordings.

• Interplay | Capture Administrator’s Guide — describes administrative concepts, tasks, and 
reference material for Interplay Capture.

All documents are available in PDF form on the Avid Knowledge Base at 
www.avid.com/onlinesupport.

http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
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Viewing Help on the Interplay Production Portal
You can quickly access the Interplay Production Help and other useful links by viewing the 
Interplay Production User Information Center on the Interplay Production Portal. The Interplay 
Production Portal is a Web site that runs on the Interplay Production Engine.

You can access the Interplay Production User Information Center through a browser from any 
system in the Interplay Production environment. You can also access it through the Help menu in 
Interplay | Access and the Interplay | Administrator.

The Interplay Production Help combines information from all Interplay Production guides in one 
Help system. It includes a combined index and a full-featured search. From the Interplay 
Production Portal, you can run the Help in a browser or download a compiled (.chm) version for 
use on other systems, such as a laptop.

To open the Interplay Production User Information Center through a browser:

1. Type the following line in a Web browser:

http://Interplay_Production_Engine_name

For Interplay_Production_Engine_name substitute the name of the computer running the 
Interplay Production Engine software. For example, the following line opens the portal Web 
page on a system named docwg:

http://docwg

2. Click the “Interplay Production User Information Center” link to access the Interplay 
Production User Information Center Web page.

To open the Interplay Production User Information Center from Interplay Access or the 
Interplay Administrator:

t Select Help > Documentation Website on Server.

Avid Training Services
Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery methods 
that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, 
please visit www.avid.com/support and follow the Training links, or call Avid Sales at 
800-949-AVID (800-949-2843).

http://www.avid.com/support


1 Installation Overview

This document describes how to use the Interplay Production Servers installer and the Interplay 
Production Clients installer to install the various Interplay components. Instructions include the 
order in which to install items and any special considerations when you are combining services 
and applications on the same system. 

See the installation check lists for the steps required to install the Interplay products.

This chapter includes the following topics:

• Using the Interplay | Production Installers

• Copying the Interplay Installers to a Server

• Creating a Recovery Image for the AS3000

• Upgrading Your System 

• Installation Check Lists

• Set Up and Configure an Avid Shared Storage System

• Network Considerations

• User Names and Passwords Required For Avid Shared Storage and Product Servers

• Required Application Keys

Using the Interplay | Production Installers
Starting with Interplay v2.7, Interplay Production installers are delivered on the Avid download 
center. See the Interplay | Production ReadMe for additional information. There are three 
separate Interplay installers: one for Interplay servers and two for Interplay clients. 

• Interplay Production Server Installer (Windows)

• Interplay Production Client Installer (Windows)

• Interplay Production Client Installer (Macintosh)

For Avid editing applications such as Media Composer, use the individual installers for the 
various Avid editing applications and then use the Interplay Client Installer to install the software 
required to make the Avid editing application a client in the Interplay Production environment. 
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n The application software for Interplay Assist and Avid Instinct® is on the Interplay Production 
Client Installer.

Additional Installation Programs on the Interplay Installers

Various installation programs for special purposes are included on the Interplay Production 
Installers, but are not accessible through the Installer user interface. You can browse the 
appropriate installer folders and select individual installers.

Copying the Interplay Installers to a Server
This topic provides instructions for copying the Interplay Installers to a server so that you have 
easy access to installer files if you should ever need them in the future. In this topic, the folder 
that contains the software installation files is referred to as the software kit.

To copy the Interplay Installers to a server:

1. Log in as Administrator. 

2. Make a folder for the software kit on the root directory (C:\) For example:

C:\Installers\Interplay_v3_2_Servers

3. Open the folder containing the installer.

4. Copy the software kit into the new folder you created. For example, use CTRL-A to select 
all the files and folders in the software kit and copy and paste to the new folder you created.

5. Navigate to the software kit folder and double-click the Autorun.exe file.

The Interplay Installer splash screen opens.

6. Install the application as described in this guide.
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Creating a Recovery Image for the AS3000

The Interplay Servers Installer includes a tool for creating a recovery image for the AS3000 
server.

The location of your AS3000 recovery image depends on the Windows OS and the Avid 
application.

• On Windows 7 systems, the recovery image is on the 16 GB flash drive that ships with the 
AS3000 server. Store the flash drive in a safe place.

• For all other systems, the recovery image ships on the D: partition of the system drive. On 
these systems, a tool for copying the image to a USB flash drive is located in the following 
locations:

- C:\Avid_Recovery_Tool\AvidRecoveryImageTool.exe

- <Interplay Server Installer>Utilities\AvidRecoveryImageTool.exe

For instructions on how to use the tool, see the Readme in the corresponding folder or see the 
AS3000 Setup Guide.

c For systems that ship with the recovery image on the D: partition, Avid highly recommends 
you copy the image to the 16 GB USB flash drive provided with your AS3000.

c When you perform a full product recovery of the Avid AS3000 system drive, you lose the 
product recovery image and data on the D: partition of the system drive.

Upgrading Your System

c Before you begin, see the Interplay | Production ReadMe for specific instructions on 
upgrading for a particular release.

The following items apply to upgrading the components on your Interplay system:

• Back up your Interplay database and any other user data before you upgrade. For 
information on backing up your database, see the Interplay | Engine and Interplay | Archive 
Engine Administration Guide.

• Use the Interplay Installer software to uninstall the previous versions of software 
components. You do not have to use the Control Panel to uninstall unless specifically 
instructed to do so in the Interplay Readme.

• Do not uninstall the Interplay Engine or Interplay Archive Engine software unless instructed 
by Avid support. Uninstalling the software could require additional steps to reactivate your 
database. When upgrading, the installation software takes care of removing the previous 
version of the software.
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Updating Intel Drivers on Cluster Systems

Do not install or update Intel NIC drivers on cluster systems after the cluster setup is complete. 
Due to the technical aspects of changing resources and devices on a cluster, this can lead to 
problems with the cluster software and possible data loss.

Deleting the Intel drivers on an establised cluster system could compromise the integrity of the 
cluster. In general, do not update the hardware drivers on a cluster system unless instructed to do 
so by the Interplay Readme or Customer Support.

n If you are reimaging the system as part of an upgrade then you can take the opportunity to 
update the Intel NIC drivers at that time.

Installation Check Lists
This section contains the following check lists:

• Overall Interplay Installation Check List

• Media Indexer Installation Check List

For information about installing the Interplay Streaming Server, see “Check List for Installing 
and Configuring the Streaming Server Software” on page 113.

Overall Interplay Installation Check List

The following check list provides an overall view of an Interplay installation.

Check List for Installing Interplay Components

Task Section Reference

 Review the recommendations in the Avid Products and 
Network Site Preparation Guide.

 Determine your Media Indexer server configuration. See the Interplay | Production Best Practices 
Guide.

 Determine where the Avid Lookup Service is running 
or where it will run. The Lookup service is part of the 
Avid Service Framework.

See “Installing the Lookup Service on a 
Separate Server” on page 96, and “Connecting 
Systems Directly to the Lookup Service” on 
page 98.
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 If you use AirSpeed Multi Stream or AirSpeed 5000 
systems, refer to the associated installation guides.

See the Avid AirSpeed 5000 Setup Guide or 
the AirSpeed Multi Stream Installation and 
User’s Guide.

 If you are using Media Services providers such as 
Interplay Transcode or Interplay Archive, 
determine where your Interplay Media Services 
Engine server will reside and where you Media 
Services providers will reside.

See the Avid Media Services Setup and User’s 
Guide.

 Check your network environment. See “Network Considerations” on page 21.

 Set up the servers that will be used in your Interplay 
environment.

See the following:

• “Configuring the Copy Provider Server” on 
page 117

• “Configuring the Move Provider Server” 
on page 125

• “Installing Cards on the Interplay Transfer 
Server” on page 128

• “SR2500 Slot Locations” on page 113

• “Installing and Configuring the Interplay 
Streaming Server” on page 107

• “Interplay | Production Port Usage” on 
page 132

 If you will be setting up a cluster (failover) 
configuration of the Interplay Engine or Interplay 
Archive Engine, set up the cluster system.

See the Interplay | Engine Failover Guide or 
the Interplay | Engine Failover Guide for 
AS3000 Servers.

 Set up and configure your Avid ISIS™ system. See “Set Up and Configure an Avid Shared 
Storage System” on page 20 and “User Names 
and Passwords Required For Avid Shared 
Storage and Product Servers” on page 22. 

 Create a Server Execution User account for the 
Interplay Engine. 

See “Creating the Server Execution User 
Account” on page 23.

Check List for Installing Interplay Components

Task Section Reference
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 On the Interplay Engine server, use the Interplay 
Servers Installer to install the Interplay Engine and 
related software.

n Make sure that you obtain and load the 
Interplay Engine license key promptly. The 
license key must match the dongle for the 
Interplay Engine server. For more information, 
see the Interplay | Engine and 
Interplay | Archive Engine Administration 
Guide.

See “Installing Software on the Interplay 
Engine Server” on page 30.

 Install and configure the Media Indexers that will 
monitor shared storage.

See “Media Indexer Installation Check List” on 
page 19.

 At this point you can install and configure the 
following applications in any order:

• Install the Interplay software components for the 
Avid editing applications.

See “Installing Software on Avid Editing 
Systems (Windows)” on page 66. See 
“Connecting the Media Indexer on an Avid 
Editing System to the Media Indexer 
Monitoring Shared Storage” on page 69.

• Install the Interplay software components and 
application software for Avid Instinct and 
Interplay Assist.

See “Installing Software on Interplay | Assist 
or Avid Instinct Systems” on page 62.

• Install and configure Interplay Transfer Engine. See “Installing Software on the Interplay 
Transfer Server” on page 41.

• Install and configure the Media Services Engine. See “Installing Software on the Production 
Services and Production Services Provider 
Servers” on page 42.

• Install and configure servers for Media Services 
such the Copy Provider server.

See “Installing Software on the Production 
Services and Production Services Provider 
Servers” on page 42 .

• Install and configure Interplay Capture. See the following Interplay | Capture 
Installation and Administration Guide.

• Install and configure the Archive Engine. This is 
similar to installing and configuring an Interplay 
Engine as described earlier in this section.

See “Installing and Configuring an Interplay 
Archive Engine” on page 85.

Check List for Installing Interplay Components

Task Section Reference
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Media Indexer Installation Check List

Starting at Interplay v3.0 and Media Composer v7.0, there is a new method for connecting to 
Media Indexer servers. Media Indexer still requires the Avid Service Framework (ASF), but it 
does not rely on ASF for communication between Media Indexer clients and servers. Instead, the 
Media Indexer uses messaging technology to communicate with the clients. The following 
checklist shows the steps required to upgrade a site to use Media Indexer v3.0 and later.

 Create the Interplay database. See “Creating an Interplay Database” in the 
Interplay | Engine and Interplay | Archive 
Engine Administration Guide.

 Create Interplay users and folder structures to match 
your project workflow and define a delete strategy.

See “Setting up a Folder Structure and a User 
Database” and “Developing a Delete Strategy” 
in the Interplay | Production Best Practices 
guide.

 Review the ISIS and Interplay maintenance 
procedures.

See the Interplay Best Practices Guide.

Check List for Installing Interplay Components

Task Section Reference

Check List for Connecting Media Indexer Servers and Clients

Task Section Reference

 Uninstall previous versions of the Media Indexer on 
Media Indexer servers and clients. Then install Avid 
Service Framework v1.8 or later and Media Indexer 
v3.0 or later on the Media Indexer servers and 
Windows Avid editing clients.

If you are upgrading a system you must delete 
the old cache files before installing Media 
Indexer v3.0 or later. See “Upgrading Media 
Indexer” on page 50.

See “Configuring Media Indexer Servers and 
Clients” on page 51.

 Install ASF v1.8 on other systems that require ASF 
such as the Lookup service system and Capture. 

You do not need to configure the Workgroup 
Properties tool on Mac clients in order to connect to 
the Media Indexer. If you need to connect them to the 
Workgroup for other reasons, use the configure.sh 
script that ships with the Media Indexer.

See “Connecting Systems Directly to the 
Lookup Service” on page 98.

See “Using the Avid Service Framework on a 
Mac OS X System” on page 57.
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Set Up and Configure an Avid Shared Storage 
System

Before you install Interplay software, install and configure your Avid shared storage system for 
shared storage. See the Interplay ReadMe for the supported versions of Avid ISIS.

Install the ISIS Client Manager on the client systems.

For information on configuring third party (3rd party) storage systems, see the Interplay Best 
Practices Guide.

Workspace Names

Use the following guidelines when creating workspace names in an Interplay environment:

• Do not use special characters or spaces in your workspace names. Workspace names should 
only contain ASCII characters.

• Keep workspace name length as short as is reasonable to allow recognition of the 
workspace. Longer workspace names add to the path length and can affect performance in a 
large Interplay environment.

 Add the Media Indexer server name to the Server 
Connection MI URL portion of the Interplay 
Administrator tool. 

See “Identifying the Media Indexer in the 
Interplay Administrator Tool” on page 54. 

 Configure the Media Indexer storage locations and 
HAG. Use the Media Indexer web interface. 

See “Configuring Media Indexer Servers and 
Clients” on page 51. 

 Start the Avid editing application. When you log into 
the Interplay database, the Avid editing system 
automatically connects to the Media Indexer HAG.

See “Configuring the Local Media Indexer on 
an Avid Editing System” on page 56.

Check List for Connecting Media Indexer Servers and Clients

Task Section Reference



Network Considerations

21

Network Considerations

This section contains topics related to setting up your Interplay network environment.

Computer Names

A hostname must comply with RFC 952 standards. For example, you cannot use an underscore 
in a hostname. For more information, see “Naming Conventions in Active Directory for 
Computers, Domains, Sites, and OUs” on the Microsoft® Support Knowledge Base. See also 
“Workspace Names” on page 20.

Verify Entries on the DNS Server

Service Framework can become sluggish and unstable if there are incorrect entries in the DNS 
server for any of the computers in the Interplay environment. Symptoms include excessive CPU 
usage by the Service Framework Lookup service and Interplay Diagnostics. The tree view in the 
Interplay Service Configuration or Health Monitor might also fail to populate if there are 
incorrect DNS entries.

Make sure that you correct any errors in DNS entries for name to IP resolution.

Configure the DNS Server to Support Reverse Lookup

If DNS is not configured for Reverse Lookup, Service Framework can not resolve IP addresses 
to host names. Symptoms include tree views failing to populate in the Interplay Service 
Configuration, Interplay Diagnostics, and Health Monitor.

Make sure the DNS server is configured to support Reverse Lookups.

Non-DNS Environments

In an non-DNS environment, you must configure a host file on all systems, including Avid Low 
Res Encode systems. This is necessary so the Service Framework can list the systems in its client 
applications, such as the Interplay Service Configuration or Health Monitor. 

Computers with Multiple Network Interfaces

Computers that have multiple network interfaces in use must be entered in DNS so that all IP 
addresses have the exact same hostname.

If you have multiple network interfaces on a computer and one is not used, use the Device 
Manager to disable the interface. If not, the computer might have problems communicating with 
the rest of the Interplay workgroup.
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Know Where Your Subnets Are on the Network

Create a system diagram that identifies the subnets on your Interplay Production environment. 
Use Unicast Discovery to allow Interplay clients to communicate across subnets. See 
“Connecting Systems Directly to the Lookup Service” on page 98.

n The Multicast Repeater service is available on the Avid Service Framework installer but the 
service is no longer recommended. Use Unicast Discovery instead.

Install Antivirus Software and Check Firewalls

See “Using Antivirus Software in an Interplay | Production Environment” on page 89 and 
Troubleshooting Firewalls and Interplay | Production.

Time Synchronization

It is important to use only one time synchronism mechanism to set the local PC clocks in the 
Interplay environment. For more information on Time Sync, see “Using Time Synchronization in 
an Interplay | Production Environment” on page 93.

User Names and Passwords Required For Avid 
Shared Storage and Product Servers

Some Avid products require user accounts on the Avid shared storage system. The user names 
and passwords on the Avid shared storage system must match the user names and passwords on 
the product server. 

n Passwords are case sensitive; the passwords must match exactly.

The following topics provide information about required user accounts:

• “Creating the Server Execution User Account” on page 23

• “Accounts for Accessing Workspaces” on page 24

• “Accounts for Using Deletion” on page 25

• “Accounts for Using Interplay Transfer” on page 26

• “Service Framework Administrator Password” on page 26

• “Accounts for Avid Editing Applications, Assist, and Instinct” on page 26

Also see “Creating Copy Provider User Accounts for ISIS and Interplay” on page 123
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Creating the Server Execution User Account

When you install the Interplay Engine software you must specify the user name and password of 
the Server Execution User account. The Server Execution User is a Windows operating system 
user account that is used only to run the Interplay Engine processes. 

n You should always use the Custom install option when installing the Interplay Engine software 
so that you can specify the Server Execution User.

You have the following options for creating the Server Execution User:

• If your Interplay system is joined to a Windows domain, you can create a domain user (for 
example, “IPEngine”). The Interplay Engine installer will associate the appropriate 
permissions with the account. If you want to run the Interplay Engine within your domain 
and also want to automatically make use of domain user management, such as Windows 
Domain or LDAP, you must specify a domain user as the Server Execution User.

For Interplay Engine failover cluster systems, you must specify a Windows domain user. 

• You have the option of allowing the Interplay Engine installer to create the account. Select a 
name before the installation and specify the name and a password during the installation. 
The installer will create a local user in the Administrators group with the appropriate 
permissions.

• You can also create a local Administrator account manually and specify that account during 
the installation. The account must have local administration rights on the operating system 
for the Interplay Engine server (both nodes on a cluster system). The account must have the 
following local security policy settings set to enabled:

- Act as part of the operating system

- Back up files and directories

- Restore files and directories

- Adjust memory quotas for a process

- Log on as a service

- Increase scheduling priorities

- Manage auditing and security log

- Impersonate a client after authentication

- Debug programs

An account with an identical user name and password must have read/write access to the Avid 
shared storage workspaces that contain media. Use the Avid ISIS Administration tool to create 
this account.
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c When you install the Interplay Engine or the Interplay Archive Engine, do not select the 
default Server Execution User. Create a custom user instead. The default user account is 
AVID_WORKGROUP_USER. Do not use this account.

Ideally the Server Execution User should be an account that users do not use to log onto the 
system. This prevents accidental changes to the Server User Account during normal 
administration duties. For example, if someone changes the password by mistake, users might 
not be able to access the Interplay database.

For security reasons, do not use the Interplay Engine server operating system Administrator 
account. Create a unique account that you use only as the Server Execution User. For example, 
you can create an administrative account called “IPEngine.” Avoiding the word Administrator 
can help indicate that this account is not used for normal administrative tasks.

n The Server Execution User account is different from the Interplay Administrator account. The 
Server Execution User account is used to run the Interplay Engine processes. The Interplay 
Administrator account is used to manage users and the database.

For more information, see “Troubleshooting the Server Execution User Account” in the 
Interplay | Engine and Interplay | Archive Engine Administration Guide.

Recreating the Server Execution User

If you have already installed the Interplay Engine and need to change the user name and 
password of the Server Execution User account, run the NXNServerUser.exe tool. For 
information on using the tool, see “Re-creating the Server Execution User” in the 
Interplay | Engine and Interplay | Archive Engine Administration Guide.  The tool is located in 
the following directory on the Interplay Installer:

Installers\AssetMgr\Tools\NXNServerUser

For information on upgrading a cluster system on which you changed the Server Execution User, 
see the Interplay | Production ReadMe. 

Accounts for Accessing Workspaces

To allow the Interplay Engine to access the Avid shared storage workspaces, you need to set up 
user accounts on both the Interplay Engine and the Avid shared storage system. The user name 
and password for these user accounts must match exactly on both the Interplay Engine and Avid 
shared storage system. If the user names or passwords are different, the workspaces are not 
available in Interplay Administrator settings, such as the Media Creation workspace in the Editor 
Settings tab of the Application Database Settings.
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The workspaces available from the Interplay Administrator settings depends on the user account 
used to log in to the Interplay Administrator. For example, when you log in to the Interplay 
Administrator server using the Administrator account, you can access all the Avid shared storage 
workspaces, provided the users are set up correctly on both the Interplay Engine and Avid shared 
storage system.

To access all workspaces:

1. Make sure the Administrator account on both the Interplay Engine and Avid shared storage 
system have exactly the same password. Passwords are case sensitive.

2. Log in to the Interplay Administrator server using the Administrator account.

To access a limited list of workspaces:

1. Make sure a user account with administrator privileges is created on the Interplay Engine 
and the same user name and password are used to create a user account on the Avid shared 
storage system. These user accounts must have exactly the same user name and password.

2. Log in to the Interplay Administrator server using this user account.

The Avid shared storage user’s workspace access privileges setting determine which 
workspaces are available.

Accounts for Using Deletion

To allow deletion in an Interplay environment, you must set up the following user accounts. You 
can use any user name and password for these accounts, but the user name and passwords must 
match exactly on all servers.

• Avid shared storage system

- Avid shared storage user with administrator privileges for Interplay Engine. This user 
must not be the Administrator account.

• Interplay Engine server

- Microsoft Windows user with administrator privileges

- Interplay Engine Server Execution User

When installing the Interplay Engine on the Interplay Engine server, select the Custom 
User Account option to create the Interplay Engine Execution User. The Server 
Execution User is the Microsoft Windows user that runs the Interplay Engine (the 
Interplay Engine Execution User). This user needs to have administrative access to the 
file server. The installer makes this user a local administrator on the Interplay Engine 
server. For more information, see “Creating the Server Execution User Account” on 
page 23.
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Accounts for Using Interplay Transfer

When you are configuring an Interplay Transfer Engine you must specify a user name and 
password that Interplay Transfer should use to connect to the Interplay engine. This user account 
must already exist on the Interplay Engine.

Service Framework Administrator Password

By default the Service Framework does not have an Administrator password. If you want to set a 
password, open the Service Framework Service Configuration tool and set the password in the 
System Configuration Service.

To set the Service Framework password:

1. Open the Service Configuration tool and click the Processes tab.

2. Select the System Configuration service and select the system running the System 
Configuration service.

3. Set the Administrator password and click Apply at the top of the dialog box.

Accounts for Avid Editing Applications, Assist, and Instinct

The following limitations exist for editing clients in an Interplay environment:

• Avid editing applications such as NewsCutter® and Media Composer®, and Symphony™ 
Nitris® that are part of an Interplay environment can use a regular Windows User login. 
However, when you install the application, you must first log in as an Administrator, install 
the application, and initially launch the application as an Administrator. See the Avid editing 
application ReadMe for details.

• Interplay Assist and Instinct have similar limitations: When you install the application, you 
must first log in as an Administrator, install the application, and initially launch the 
application as an Administrator. You can then subsequently run the application as a regular 
User. 

See “User Names and Passwords Required For Avid Shared Storage and Product Servers” on 
page 22. Check the Interplay ReadMe for any changes to the Windows login permissions. 
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Required Application Keys
The following systems require a hardware application key (also known as a dongle):

• Interplay Engine server. Also requires a software application key. For more information, see 
“Installing Software on the Interplay Engine Server” on page 30.

• Interplay Media Services Engine server

• Interplay Transfer server

n When installing the Interplay Transfer Engine in a standalone environment, a hardware 
application key is not required. The Avid editing software handles the licensing of the Interplay 
Transfer Engine.

• Media Services:

- Interplay Archive

- Interplay Restore

- Interplay Transcode

- Interplay Delivery

- Interplay Delivery Receiver

- Interplay Copy

- Interplay Move

- STP Encode

An application key can be programmed for multiple applications, so that you can use more than 
one application on the same server. For more information, contact your Avid representative.

c Do not lose the USB application key. Your software does not function without it. If you lose 
your application key, you must purchase another key from Avid at the full market cost of 
your software.



2 Installing Software on Interplay Servers

The following topics describe the installations of the Interplay software on the servers:

• Selecting the 32-Bit or 64-Bit Version of Avid Service Framework

• Starting the Interplay Server Installer

• Installing Software on the Interplay Engine Server

• Installing Software on the Interplay Transfer Server

• Installing Software on the Production Services and Production Services Provider Servers

• Installing Software on an Interplay | Media Indexer Server

• Installing Software for Interplay Web Services

• Installing the MediaCentral Distribution Service

For information on the order of installation and configuration, see “Installation Check Lists” on 
page 16.

For information on installing the Interplay Streaming Server, see “Installing and Configuring the 
Interplay Streaming Server” on page 107.
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Selecting the 32-Bit or 64-Bit Version of Avid Service 
Framework

For Interplay version 3.1 or later, the following components run as 64-bit versions and require 
the 64-bit version of Avid Service Framework:

• Interplay Transcode Provider v2.5 and later

• Interplay STP Encode Provider v2.5 and later

• Interplay Media Services Engine v2.7 and later

• Interplay Media Services and Transfer Status v2.7 and later

• Interplay Archive v3.0 and later

• Interplay Copy v2.7 and later

• Interplay Move v2.7 and later

• Interplay Delivery v2.7 and later

• Interplay Transfer v3.0 and later

• Interplay Delivery Receiver v3.0 and later

• Interplay Auto Media Services v2.7 and later

• Avid Media Composer v6.0, Avid Symphony v6.0, NewsCutter v10.0 and later

• Interplay Assist v2.5 and later

• Instinct v4.0 and later

• Interplay Capture v3.1 and later

n Starting with Interplay version 3.0, the Interplay Engine, Interplay Archive Engine, and 
Interplay Failover Cluster are 64-bit applications. Avid Service Framework is not usually 
installed with these applications.

The following is still a 32-bit application:

• Interplay Streaming Server. Installation of the Avid Service Framework is optional. If you 
install it, use the version on the Streaming Server Installation page. 

c Do not install both the 32-bit Framework and the 64-bit Framework on the same system.
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Starting the Interplay Server Installer
To start the Interplay Server Installer:

1. In the Interplay Server Installer folder, double-click autorun.exe.

The Main Menu window opens.

The Main Menu window allows you to select the installers required by a particular Interplay 
component. The list is divided into Interplay servers, individual optional installers, and Interplay 
SDKs. 

n Items with three dots open a new window. Items without three dots start an installer.

Installing Software on the Interplay Engine Server
These instructions are for a system with a single Interplay Engine or Interplay Archive Engine. 
For specific information about an Interplay Archive Engine, see “Installing and Configuring an 
Interplay Archive Engine” on page 85. If you are installing software on a system with cluster 
services, see the Interplay | Engine Failover Guide.

c If you are upgrading an Interplay Engine, see the Interplay | Production ReadMe before 
proceeding. The Readme contains any specific instructions for upgrade the Interplay 
Engine for a particular release.
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To install the Interplay Engine Server:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Interplay Engine

2. Install components from the following table:

3. Perform the installation in the order shown in the above list. You have to reboot the server 
after the Interplay Engine installation.

Installing the Interplay | Engine Software

The first time you install the Interplay Engine software, you must select Custom installation. 
Selecting Custom installation lets you specify the Server Execution User and other configuration 
information correctly.

If you are upgrading, you should also use Custom installation to verify that the settings are 
correct. For example, during a Custom installation you can verify the name of the Server 
Execution User. 

n If you are installing or upgrading a cluster system, see the Interplay Production ReadMe and the 
Interplay | Engine Failover Guide.

n If you are installing an Interplay Archive Engine, see “Installing and Configuring an Interplay 
Archive Engine” on page 85.

To install the Interplay Engine software:

1. Before you begin, do the following:

t Make sure that the Interplay Engine application key is installed on the server system. 
For more information, see “Required Application Keys” on page 27.

The Interplay Engine also requires a software license. Install this license after installing 
the Interplay Engine software, as described at the end of this procedure.

Component Description

Interplay Engine The full Interplay Engine software. See “Installing the 
Interplay | Engine Software” on page 31.

Access Required to communicate with the Interplay Engine database. Installing 
Interplay Access also installs the Interplay Administrator. See 
“Installing Interplay | Access” on page 41.
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t Make sure you have created matching accounts on the Interplay Engine system and the 
Avid shared storage system. You need to type the user name and password during 
installation to create the Server Execution User. See “Creating the Server Execution 
User Account” on page 23.

t Close all Windows programs.

2. Select the following from the Interplay Server Installer Main Menu:

Servers > Interplay Engine > Interplay Engine

3. In the Welcome dialog box, read the information about the installation of the Apache server. 
Click Next.

4. Read the license agreement information and then accept the license agreement by selecting 
“I accept the agreement.” Click Next.

The Specify Installation Type dialog box opens.

5. Select one of the following and click Next:

t If this is a new installation, select Custom. This ensures that you identify the Server 
Execution User required by the Interplay Engine. 

n Avid recommends that you always use the Custom installation option so that you can view the 
Server Execution user name and review other settings as you proceed with the installation.

t If this is an upgrade, select Typical and proceed to step 18. (Both the Typical and 
Custom installation use the existing settings.)

The Specify Destination Location dialog box opens.
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6. Specify the destination folder and click Next.

The Destination Location is the folder in which the Interplay Engine program files are 
installed. In most cases, keep the default, which installs the files in an Avid Interplay Engine 
subfolder in the Program Files folder.

The Specify Default Database Folder dialog box opens.

7. Accept the default folder and click Next.
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The database folder is the folder in which the database is created and stored. This location 
must be local, that is, the database folder must be installed on the Interplay Engine server. 
No other configuration is supported. By default the database folder is created at the root of 
the D: drive as D:\Workgroup_Databases. All access rights are set automatically.

If you previously installed the Interplay Engine software, this field displays the share name 
that appears in the next dialog box.

The Specify Share Name dialog box opens.

8. Accept the default share name and click Next.

By default, the share name is “WG_Database$.” The “$” at the end makes the share invisible 
if you browse through the network using Windows Explorer. For security reasons, Avid 
recommends keeping the default setting and using a “$” at the end of the share name. With 
this default setting, the folder “D:\Workgroup_Databases” on the Interplay Engine computer 
is shared under the name “WG_Database$.” 

The Specify Configuration Server dialog box opens.

9. Select the Interplay Engine you want to use as the Central Configuration Server and click 
Next.

The Central Configuration Server (CCS) is an Interplay Engine with a special module that is 
useful if you are working in an environment that includes more than one Interplay Engine 
(including an Interplay Archive Engine). However, even if you are working in an 
environment with one Interplay Engine, you need to specify a CCS.

Select one of the following:

t This Avid Interplay Engine: Specifies that the Interplay Engine that you are installing 
should be the CCS. Click Next.
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t Another Avid Interplay Engine: Specifies that a previously installed Interplay Engine 
should be the CCS. An additional dialog box opens. Type the name of the Interplay 
Engine to be used as the CCS and click Next.

If you want to specify another Interplay Engine, you must specify an Interplay Engine that is 
already installed. If you have not yet installed the desired Interplay Engine, specify the 
current Interplay Engine, install the desired Interplay Engine, and then change the CCS 
through the Interplay Administrator. See “Understanding the Central Configuration Server” 
in the Interplay | Engine and Interplay | Archive Engine Administration Guide.

c If you specify an Interplay Engine that is not yet installed, you might not be able to log onto 
the system. See “Troubleshooting Log-in Problems” in the Interplay | Engine and 
Interplay | Archive Engine Administration Guide.

The Server Execution User dialog box opens.

10. Select Custom user account and click Next.

The Server Execution User is a Windows account that has administrative access to the 
Interplay Engine. This account also needs to have administrative access to the shared storage 
workgroup. Avid requires that you create a custom user account. For more information, see 
“Creating the Server Execution User Account” on page 23.

The Specify Server User dialog box opens.
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a. Type a local user, for example, “IPEngine,” or type a domain user, such as 
“MYDOMAIN\IPEngine.” Make sure this user name exactly matches the user name of 
an Avid shared storage account with administrator privileges.

b. Type the password. The installer cannot check the password you type in this dialog box. 
Make sure that the password exactly matches the password for the Avid shared storage 
user with administrator privileges. If the user name and password do not match those of 
the Avid shared storage user, the Interplay Engine will not run properly. Confirm the 
password.

n You can change the Server Execution User after installation. See “Troubleshooting the Server 
Execution User Account” in the Interplay | Engine and Interplay | Archive Engine 
Administration Guide.

c. Click Next.

The Specify Server Name dialog box opens. 
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11. Specify the server name as it appears on the network and click Next.

By default, the computer’s name is specified as the server name. Interplay clients use this 
name to identify the server. If there are clients in your network that are unable to resolve 
hostnames to IP addresses, you have to specify the server’s IP address here. In this case, the 
server needs a static IP address; be sure to configure your DHCP server accordingly.

n A hostname must comply with RFC 952 standards. For example, you cannot use an underscore in 
a hostname. For more information, see “Naming Conventions in Active Directory for Computers, 
Domains, Sites, and OUs” on the Microsoft Support Knowledge Base.

The server name entered should not be more than 15 characters. Server names longer than 15 
characters will be truncated and might cause problems with client connections if there is more 
than one machine in the network with the same truncated name.

The Specify Preview Server Cache dialog box opens.
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12. Accept the default location and click Next.

Interplay Access lets you view a thumbnail image or other representation of a file asset. This 
feature requires a special cache folder. The default folder for the preview server cache is 
named PreviewServer and is installed in the default database folder.

The Enable E-mail Notification dialog box opens.

13. Enable email notification and click Next.
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The email notification feature sends emails to your administrator when special events, such 
as “Disk Full” and “Out Of Memory,” occur. See “Configuring the Server Event Manager” 
in the Interplay | Engine and Interplay | Archive Engine Administration Guide for details on 
configuring the email notification.

The E-mail Notification Details dialog box opens.

14. Supply the following information:

a. Type the administrator’s email address and the email address of the server that is the 
sender. If an event such as “Disk Full” occurs on the server, the administrator receives 
an email from the sender’s email account explaining the problem, so that the 
administrator can respond to the problem. 

b. Type the static IP address of your SMTP server. The notification feature needs the 
SMTP server in order to send emails. If you do not know this IP address, ask your 
administrator. 

c. (Option) If you also want to inform Avid Support automatically through email if 
problems arise, select the option “Send critical notifications also to Avid Support.”

d. Click Next.

The installer modifies the file Config.xml in the Avid Interplay Engine\Data\Server\Config 
directory with your settings. The Ready to Install dialog box opens.

15. If you are ready to complete the installation, click Next.
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All necessary components are installed. It might be necessary for the installation program to 
install additional components, such as Adobe Reader.

If any system libraries on your machine need to be upgraded to complete the installation 
process, the installation program asks you to reboot your machine. Save all your open 
documents, close all applications, and then click the OK button to reboot.

The installation finishes and the Installation Completed dialog box displays the success or 
failure of each installation.

16. Click Finish. 
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A dialog box requesting a reboot opens. A message with instructions on how to fix any 
installation problems also appears.

17. Click OK to reboot the machine.

18. Enable a permanent license key. See “Managing Licenses” in the Interplay | Engine and 
Avid Archive Engine Administration Guide for instructions. Make sure that you obtain and 
load the Interplay Engine license file promptly. The permanent license key must match the 
application key (dongle) for the Interplay Engine server.

Installing Interplay | Access

You must install Interplay Access on the Interplay Engine. Avid recommends that you accept the 
defaults. 

Installing Interplay Access also installs the Interplay Administrator. 

To install Interplay Access:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Interplay Engine > Access

After the installer starts, the Introduction dialog box opens.

2. Close down all other programs, then click Next. 

3. Complete the installation by accepting the defaults. If you want to install the Microsoft 
Office and Adobe Photoshop plug-ins, accept the default paths.

4. When you finish the installation, the installation program might require you to reboot the 
system. 

Installing Software on the Interplay Transfer Server
To install Interplay software on the Interplay Transfer server:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Transfer Engine

2. Install components from the following table:

Component Description

Service Framework 
for Client

The installer automatically installs the components required for an 
Interplay Transfer application.

Access Installs the Interplay Access and Interplay Administrator applications.
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See the Interplay | Transfer Setup and User’s Guide for details on installing and configuring 
the Interplay Transfer software.

Installing Software on the Production Services and 
Production Services Provider Servers

This section provides an overview of installing the Production Services and Production Services 
Provider servers. The following illustration shows the initial installer screen.

Transfer Engine For information on configuring the Interplay Transfer server and the 
Interplay Media Services and Transfer Status application, see the 
Interplay Transfer Setup and User’s Guide.

Production Services 
and Transfer Status

(Option) Lets you monitor Interplay Transfer jobs as well as Interplay 
Production Services jobs from any computer in the network.

Avid Interplay 
Transfer Cache 

(Option) Lets you install only the Interplay Transfer Cache. The 
Transfer Cache Engine runs in the background and allows you to 
monitor transfers in the workgroup.

Component Description
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Installing the Production Services Engine

The first screen links to the installers for Interplay Production Services. 

n Microsoft SQL Server 2012 Express is installed automatically when Interplay Production 
Services Engine is installed. Configuration is also automatic. If you are upgrading the Media 
Services Engine, existing databases are automatically upgraded.

To install the Interplay Production Services engine:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Production Services > Production Services

The Install Production Services window opens.

2. Install components from the following table:

3. Configure the Production Services Engine for the Interplay workgroup.  See the 
Interplay | Media Services Setup and User’s Guide.

n If you are performing an upgrade, you do not have to reregister existing services such as the 
Transcode service or Archive service or existing providers.

Installing the Local Workflow Components

Use this installer screen to install the local workflow providers. After installing the software, you 
need to register and configure the providers. For additional information, see the 
Interplay | Media Services Setup and User’s Guide.

Component Description

Service Framework 
for Client

Select the Framework installer. This is an installer for 64-bit systems.

Access Installs the Interplay Access and Interplay Administrator applications.

Required software to configure the Production Services Engine with the 
Interplay server.

Production Services 
Engine

Installs the 64-bit Interplay Production Services Engine.

During the installation, if an Interplay Production Services database 
already exist on the server, the “Avid Interplay Database” dialog box 
opens. Select one of the following:

• Upgrade exiting database (default)—to use the existing database.

• Overwrite current database—if you want to remove all users, 
providers, and services.
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To install the Local Workflow Components:

1. On the system that you want to install the provider, select the following from the Interplay 
Server Installer Main Menu.

Servers > Production Services > Install Local Workflow Support

The Install Avid Interplay Production Services Local Workflow window opens.

2. Select the service provider that you want to install.

Component Description

Access Installs the Interplay Access and Interplay Administrator applications.

Recommended for installation on each provider.

Transcode The Transcode service provider. Allows you to define profiles and 
launch transcode jobs from Access or the Avid editing application.

The Interplay Transcode installer includes an option in which you select 
whether you want to mount workspaces as drive letters or UNC paths. 
Select UNC paths if the number of workspaces required for the client 
exceeds the available drive letters. Change the server's ISIS client 
preferences match the setting you choose.

The Interplay Transcode installer includes an option that lets you select 
the number of instances of the Transcode provider that you want to 
install. See “Installing Multiple Transcode Providers on the Same 
Server” on page 45.

STP Encode Allows you to off load time-consuming processing involved in 
exporting and transferring of Long GOP OP1a media, during a 
send-to-playback request from the Avid editing application or Interplay 
Assist.

n Do not install STP Encode and Interplay Transcode providers on 
the same system.

The Interplay STP Encode installer includes an option in which you 
select whether you want to mount workspaces as drive letters or UNC 
paths. Select UNC paths if the number of workspaces required for the 
client exceeds the available drive letters. Change the server's ISIS client 
preferences match the setting you choose.

 Archive The Archive provider. Typically installed on its own server. See 
“Installing the Interplay Archive Provider Software” on page 87.

Copy The Interplay Copy provider. Typically installed on its own server. See 
“Configuring the Copy Provider Server” on page 117.

Move Allows you to move media for Avid assets (both .mxf and .omf files) 
from one Avid ISIS workspace to another.
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Installing Multiple Transcode Providers on the Same Server

Interplay Transcode v3.0 and later is qualified to run as multiple instances on the same server. 
Up to four providers are supported, depending on the total amount of CPU used.

Determining the Number of Providers to Install

To determine the optimum number of providers to install on a server, check the system resources 
currently used for your Transcode workflows. Open the Task Manager and click the Performance 
tab to display information about CPU usage. When jobs typical to your workflow are running, 
note the average percentage of CPU used. The following illustration shows a Transcode job in 
process that is using 14 percent of the CPU.

Use the formula 100/CPU Usage Percentage to estimate the number of providers you can use. 
For example, if the average CPU usage is 25 percent, you can use four Transcode providers on 
the server. The maximum number of providers supported on a single server is four.

Production Services 
and Transfer Status

Lets you monitor Interplay Transfer jobs as well as Interplay Production 
Services jobs on a standalone system. You don’t need to install this 
software on the Production Services system as the function is built into 
the Production Services Engine software.

Auto Production 
Services (Optional)

Installs the Interplay Auto Production Services. The Interplay Auto 
Archive installation includes the Auto Archive, Auto Transcode, Auto 
Transfer, and Auto Copy services. 

Component Description
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n Complex mixdowns require much more memory than transcoding. If your workflow involves 
complex mixdowns you should install a maximum of two providers on the same server.

Requirements

• AS3000 dual-processor server with 12 GB of RAM, running Windows 7 Professional SP1 
64-bit

• License and application key (dongle) for multiple Transcode providers.

Starting with Interplay Transcode v3.0.5, an Interplay Transcode dongle includes support for 
multiple Transcode providers on a single system.

Installation

The Interplay Transcode installation program includes an option that lets you select the number 
of instances of the Transcode provider that you want to install. Select the number of transcode 
providers specified in your license and dongle. 

The installation program installs executable files for the number of providers you selected, 
named DMSTranscode.exe, DMSTranscode 2.exe, and so on. It also installs one Service 
Description file (.zip file).

For information on configuring providers, see the Interplay | Media Services Guide or the 
Interplay Help. Use a different name for each provider.
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Using the Providers

After you configure each provider, you can create profiles and send jobs as you would for 
providers that are on individual servers.

Installing Avid Service Framework for Local Workflow Components

All local workflow components require the 64-bit version of Avid Service Framework for Client.

To install the Framework for the local workflow components:

1. Navigate to the following installer page:

Servers > Production Services

2. Select Service Framework for Client.

Installing the WAN Workflow Components

Use this installer screen to install the WAN workflow providers. The Delivery service provider 
and the Delivery Receiver service allow you to transfer clips, shotlists, and cuts only sequences 
and the media files to another workgroup. 

n You also install the Interplay Streaming server as part of the WAN workflow. See “Installing and 
Configuring the Interplay Streaming Server” on page 107.

To install the Production Services WAN Workflow Components:

1. On the system that you want to install the provider, select the following from the Interplay 
Server Installer Main Menu:

Servers > Production Services > Install WAN Workflow Support

The Install Production Services WAN Workflow window opens.

2. Select the service provider that you want to install.

Component Description

Delivery The Interplay Delivery service provider. The Delivery service provider 
and the Delivery Receiver service allow you to transfer clips, shotlists, 
and cuts only sequences and the media files to another workgroup. You 
can also use profiles to only transfer the portion that is used in a subclip.

Delivery Receiver The Interplay Delivery Receiver service. The Delivery Receiver service 
lets the workgroup receive transfers from a workgroup with the 
Delivery service. 
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For information on the Delivery and Delivery Receiver providers, see the Interplay | Media 
Services Setup and User’s Guide.

Installing Avid Service Framework for WAN Workflow Components

Interplay Delivery and Interplay Delivery Receiver require the 64-bit version of Avid Service 
Framework for Client:

To install the Framework for the WAN Workflow Components:

1. Navigate to the following installer page:

Servers > Production Services

2. Select Service Framework for Client.

Installing the Media | Index Components

Use this installer screen to install Production Services providers that are used in MediaCentral 
workflows. Media Index runs on the MediaCentral Platform and provides a central index for 
multiple Interplay Production databases. The Production Services Automation provider and the 
Consolidate provider work together to deliver assets and media that a user finds through a search 
of the central index. For more information, see the Avid MediaCentral Platform Services 
Installation and Configuration Guide.

To install the Production Services WAN Workflow Components:

1. On the system that you want to install the provider, select the following from the Interplay 
Server Installer Main Menu:

Servers > Production Services > Install Media | Index Support

The Install Media | Index Support window opens.

2. Select the service provider that you want to install.

Installing Avid Service Framework for Media | Index Components

Interplay Production Services Automation and Interplay Consolidate require the 64-bit version 
of Avid Service Framework for Client:

Component Description

Production Services 
Automation

This service handles the logic of chaining a consolidate job and a 
delivery job. It triggers a consolidate job and monitors its status. If the 
consolidate job is successful, it triggers a delivery job..

Consolidate This service uses the In and Out marks specified for a loaded clip or 
subclip to create a new media and asset.
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To install the Framework for the Media Index components:

1. Navigate to the following installer page:

Servers > Production Services

2. Select Service Framework for Client.

Installing Software on an Interplay | Media Indexer 
Server

The following topics describe how to install software on an Interplay Media Indexer Server:

• “Different Types of Media Indexers” on page 49

• “Before Installing Media Indexer Software” on page 50

• “Using UNC Drive Mapping on Interplay ISIS” on page 50

• “Installing the Media Indexer Software” on page 50

• “Configuring Media Indexer Servers and Clients” on page 51

Different Types of Media Indexers

Avid recommends that you use one or two 64-Bit Media Indexers to monitor shared storage. You 
can add a second 64-bit Media Indexer for redundancy. For additional information and for a 
procedure for replacing existing Media Indexers with a 64-bit Media Indexer, see the 
Interplay | Production Best Practices guide.

There are three basic ways to configure a Media Indexer:

• The leader of a High Availability Group. The leader can index shared storage and it can also 
monitor other Media Indexers. On a small configuration, the Media Indexer software might 
be installed on the Interplay Engine. In this case, configure a High Availability Group with 
one member configured on the Interplay Engine.

n You always need a High Availability Group to monitor shared storage, even if it is a group of 
one.

• Additional members of a High Availability Group. Members that you add to a High 
Availability group (HAG) provide redundancy and load balancing for the leader.

• The Media Indexer on each Avid editing application system. These local Media Indexers 
connect to the High Availability Group.

For information on the maximum number of files that a Media Indexer can monitor, see the 
Interplay | Production Best Practices guide and the Interplay | Production ReadMe.
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Before Installing Media Indexer Software

The following are important for a successful Media Indexer configuration:

• Before you configure Media Indexer on a Windows system, install the Service Framework 
software and verify that it’s running. For additional information, see “Verifying that the 
Service Framework Services Are Running” on page 81.

• Before you configure Media Indexer to monitor your Avid shared storage workspaces, the 
workspaces must have an Avid MediaFiles folder. To create the folder, you can either use an 
Avid editing application to capture or import media to the workspace or you can manually 
create an Avid MediaFiles folder.

• Do not use spaces or special characters in your workspace names.

Using UNC Drive Mapping on Interplay ISIS

On Avid ISIS, you must select the “Use UNC (Letterless) Drive Mapping” option on the Media 
Indexers that monitor shared storage. 

To set UNC Drive Mapping:

t In the ISIS Client Manager window, select Preferences and select the letterless option.

For more information, see “Mounting Workspaces as Drives: Lettered versus Letterless” on 
page 91 and “Installation Check Lists” on page 16.

Upgrading Media Indexer

To upgrade Media Indexer:

1. Uninstall the Media Indexer on servers and clients.

2. Delete the Interplay Media Indexer directory on servers and clients. This will delete the old 
MI cache files.

3. Install the latest versions of ASF and Media Indexer on the servers and Windows clients.

4. Install Access and the Media Indexer on Mac OS X systems. See “Installing Media Indexer 
on a MacOS X System” on page 72.

5. Configure the Media Indexer servers and clients.

Installing the Media Indexer Software

To install the Media Indexer Server:

1. Select the following from the Interplay Server Installer Main Menu:

Servers >Media Indexer
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2. Install components from the following table:

Configuring Media Indexer Servers and Clients

Starting at Interplay v3.0, the Avid Service Framework (ASF) is no longer used to make the 
connection between the Media Indexer servers and the Avid editing applications. However, the 
following ASF components are still required:

• ASF must be installed on the Media Indexer servers and Windows Avid editing clients as in 
previous releases.

• Use the Workgroup Properties tool to connect the Windows clients and servers to the 
Lookup Service.

• Mac OS X clients do not require ASF configuration to connect to the Media Indexer. 
However, they may require ASF for other reasons. See “Using the Avid Service Framework 
on a Mac OS X System” on page 57.

• The Media Indexer HAG is still required. Define the HAG using the Media Indexer web 
interface. 

Note that if you add an older editing application (for example, Media Composer v6.5.3) to an 
Interplay v3.0 or later environment, you must use the ASF Service Configuration tool to add the 
editor system to the HAG.

Configuring Media Indexer Servers

This section describes how to configure the Media Indexer server using the MI web interface. 

To configure the Media Indexer server:

1. Open the web interface on the Media Indexer server using the following URL:

http://<MI system name>:8888/mi/

Component Description

Service Framework 
for Server

Perform the installation on primary and secondary shared storage Media 
Indexers.

Access Allows for easy access to the Interplay Engine. This also installs the 
Interplay Administrator.

Media Indexer  Installs the Media Indexer software.
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where <MI system name> is the server name or IP address of the system running the Media 
Indexer. If you are logged onto the MI server, you can use localhost for the MI server 
name.

2. Click the Configuration tab and then click the Cache and HAG Information tab.

The following illustration shows a completed section. 

3. Click the Join High Availability Group check box. 

4. Enter the Name of the HAG and enter the weight of this Media Indexer in the HAG. In this 
example, the name of the HAG is “HAG.” The Media Indexer with the highest weight is the 
leader of the HAG. 

n Avoid using values of 0 or 1 for the weight and avoid using consecutive numbers for the weights. 

To Add Storage Locations to the Media Indexer Server:

1. Click either the Add Storage Location or Add AMA Storage Location button as follows:

- Use Add Storage Locations for .mxf files on shared storage.

- Use Add AMA Storage Location for AMA media. See “Configuring the 
Interplay | Media Indexer to Index AMA” on page 120.

n You can only add or modify storage locations on the HAG leader.

2. Click OK to save the configuration.
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3. Add additional storage locations as necessary. Use UNC path notation for adding locations 
to index or to describe AMA media locations when pointing to shared storage (ISIS).

The following illustration shows an MI configured with several .mxf and AMA storage 
locations. The AMA locations are represented by a folder icon.

Adding an Additional Media Indexer to the HAG

You can use the MI web interface or the Service Configuration tool to add Media Indexers to the 
HAG for redundancy.

To use the web interface to add an additional Media Indexer:

1. Open the web interface for the second MI server.

2. Click the Configuration tab and then click the Cache and HAG Information tab.

3. Click the Join High Availability Group check box and enter a weight lower than the leader. 

If you click the Storage Locations tab you should see the same storages locations as the 
leader. In this case they will be Read Only. 

4. Add the new Media Indexer to the Interplay Administrator tool as described in the following 
section.
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Identifying the Media Indexer in the Interplay Administrator Tool

The following applications use the Server MI Connection URL setting in the Interplay 
Administrator tool to locate the Media Indexer servers.

• Avid editing applications

• Production Services Transcode provider

• STP Encode

• Interplay Transfer engine

• Assist and Instinct

n Interplay Access continues to use the Workgroup Name portion of the Interplay Administration 
tool to connect to the Media Indexer.

To identify the MI Connection URL in the Interplay Administration tool:

1. Open the Interplay Administrator tool and open the Server Hostname Settings view.

2. In the Workgroup and Media Indexer Settings section, locate the Server MI Connection 
URL section.

3. Click the Add button to add a Media Indexer server.

The following illustration shows a completed section.
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4. Add the name of the MI server and click Apply Changes.

5. If you have more than one MI in the HAG, add the other MI servers also. Note that 
additional Media Indexer servers must join the HAG in order to connect to the URL.

The system creates a URL for the Media Indexer server and displays the URL below the MI 
Servers window. The URL contains the MI server name and port 61717. This is the default 
port used to connect to the Media Indexer server.

n See “Configuring the Interplay | Media Indexer to Index AMA” on page 120 for information on 
the AMA Shared Storage Location.

n Instinct and Assist continue to use the Workgroup Name portion of the Workgroup and Media 
Indexer Settings section. Add the workgroup name to that section (case sensitive).
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Configuring the Local Media Indexer on an Avid Editing System

You do not need to explicitly add the local Media Indexer to the HAG. If the “Server MI 
Configuration URL” is correctly set in the Interplay Administration tool, the Avid editing 
application will automatically connect to the HAG when you log into Interplay.

Do not use the “Connect to AMQ server MI” button on the web interface to make an explicit 
connection to the Media Indexer HAG. This option is overridden by the value in the Interplay 
Administrator tool at login time.

To connect an Avid editing application to the Media Indexer HAG:

1. Configure the Administrator tool to recognize the Media Indexer HAG. See “Identifying the 
Media Indexer in the Interplay Administrator Tool” on page 54.

2. On your Avid editing system, start the editor and then log into the Interplay database using 
one of the following methods:

- Log in using the Project Select dialog that opens when you start the editor.

- Log in using the Interplay Server and Interplay User dialogs in the Settings window.

After you log into the Interplay database, your local Media Indexer will automatically 
connect to the Media Indexer in the HAG. 

n The Windows Avid editing application restarts the local Media Indexer service each time you 
restart the editor application. This does not happen on the Mac OS X systems.

n When you start the Avid editing application, there is an initialization period named “Connecting 
to the Media Indexer.” This process connects to the local Media Indexer.

3. (Option) Open the Media Indexer web interface, select the Avid editing system, and view the 
connection to the HAG.

The system displays the storage locations for the Media Indexer server as shown in the 
following illustration. Note that mxf file locations are displayed but AMA file locations are 
not displayed in this section.
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Using the Avid Service Framework on a Mac OS X System

You do not have to connect to the Avid Service Framework (ASF) in order to connect to the 
Media Indexer HAG. However, you can configure your connection to the ASF workgroup for the 
following situations:

• If your editing system is in a different subnet from the Media Indexer server you may need to 
configure ASF and connect to the Lookup service.

• If you would like to configure ASF in order to view your system in the Service 
Configuration tool on other systems. If you do not configure ASF, the Mac system will not 
display in the Service Configuration tool. 

Use one of the following methods to connect to the workgroup on a Mac OS X system:

• If your Interplay environment has only one Lookup Service, you can run the configure.sh 
script to change the workgroup name and the name of the Lookup Service.

• If your system has two Lookup services, you must run the Interplay Administrator tool as 
root to add both Lookup services. The configure.sh command only configures for one 
Lookup service.

To run the configure.sh script:

1. Open a terminal window and navigate to the bin folder as follows:

cd /Applications/Avid/Media\ Indexer/bin

Note that the back slash ( \ ) is used to add a space to the path name.

2. Type the following command:

sudo ./configure.sh <Workgroup name> <name of Lookup Service system>
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enter the workgroup name and the name of the system running the Lookup Service separated 
by a space. For example:

sudo ./configure.sh UptimeWG burl-mi02

3. The Terminal window might prompt for your password. Type your administrator password 
and press Return.

4. Restart the Media Indexer. See “Restarting the Media Indexer Service on a Mac OS X 
System” on page 59.

To run the Interplay Admin tool as root and change the Workgroup Properties:

1. Open a terminal window and navigate to the folder that contains the Admin tool executable 
as follows:

cd /Applications/Avid/Interplay\ Access/InterplayAdministrator.app/
Contents/MacOS

Note that the back slash ( \ ) is used to add or “escape” a space in the path name.

2. Type the following command:

sudo ./AvidInterplayAdministrator

The Interplay Administrator tool starts. If the command does not start the application, restart 
your Mac system and try again.

n You must have an Administrator login to perform commands that begin with “sudo.”

3. Open the Workgroup Properties tool in the Avid Services view.

4. If necessary, change the workgroup name and add or change the system that runs the Lookup 
Service and click Apply.

n Do not use the Service Configuration tool to set the connection to the HAG.

5. After you make the changes, restart the Media Indexer service to restart the Framework 
services. See the following section on restarting the Media Indexer service.

n When you click Apply in the Workstation Properties tool, the system asks whether you want to 
restart the services. However, it does not restart the services automatically on a Mac. You must 
restart the Media Indexer service manually.

After you exit the application, the system displays a message about the Logging Subsystem. 
You can ignore the message.
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Restarting the Media Indexer Service on a Mac OS X System

This section describes how to restart the Media Indexer service. Note that every time you restart 
the Avid editing application in Media Composer v7.0 on a Windows system, the system 
automatically restarts the Media Indexer service. On a Mac OS X system you must manually 
restart the service. 

To restart the Media Indexer process from a Terminal window:

1. Open a terminal window and navigate to the Media Indexer/bin directory as follows:

cd /Applications/Avid/Media\ Indexer/bin

2. Type the following commands in the bin directory:

sudo ./mi.sh remove
sudo ./mi.sh install

where:

- sudo instructs the system to run the command as “super user” or root.

- the characters ./ instruct the system to “run the following command that resides in the 
current directory”.

n You must have an Administrator login to perform commands that begin with “sudo.”

Installing Software for Interplay Web Services
The Interplay Web Services SDK provides third parties with a rich set of functions to integrate 
tightly with an Interplay environment.For more information, read the documentation that is 
installed with the SDK.

Before installing Interplay Web Services, install and configure the Avid Service Framework. See 
“Selecting the 32-Bit or 64-Bit Version of Avid Service Framework” on page 29.

To install Interplay Web Services

1. Select the following from the Interplay Server Installer Main Menu:

Interplay SDKs > Web Services

After the installer starts, the Introduction dialog box opens.

2. Accept the license agreement and follow the installation instructions.
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Installing the MediaCentral Distribution Service

The Avid MediaCentral Distribution Service (MCDS) coordinates and monitors 
send-to-playback and mixdown operations for Interplay Central. It determines if there is any 
preprocessing required. If it determines an audio mixdown is required, it submits a Transcode 
Mixdown request. If Long GOP media is required, it submits an STP Encode request. You can 
configure your workgroup for more than one MCDS.

For more information, see the Avid MediaCentral Platform Services Installation and 
Configuration Guide.

To install the MediaCentral Central Distribution Service:

1. Open the Installers folder at the top level of the Servers installation media.

2. Open the CentralDistributionService folder.

3. Double-click setup.exe.

4. Follow the installation instructions.



3 Installing Software on Interplay Clients

The following topics describe the Interplay software installation on Interplay clients:

• Starting the Interplay Client Installer

• Installing Software on Interplay | Assist or Avid Instinct Systems

• Installing Interplay | Access

• Installing Media Composer | Cloud Components

• Installing Software on Avid Editing Systems (Windows)

• Installing Software on Avid Editing Systems (Macintosh)
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Starting the Interplay Client Installer
To start the Interplay Client Installer:

1. In the Interplay Client Installer folder, double-click autorun.exe.

The Main Menu window opens.

The Main Menu window allows you to select the installers required by a particular Interplay 
component. The list is divided into Interplay clients and individual optional installers. 

n Items with three dots open a new window. Items without three dots start an installer.

Installing Software on Interplay | Assist or Avid 
Instinct Systems

This section describes how to install Interplay Assist or Instinct software.

Interplay Assist and Avid Instinct must be installed and initially launched by an Administrator. 
See “Accounts for Avid Editing Applications, Assist, and Instinct” on page 26.
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To install Interplay Assist or Avid Instinct software:

1. Select one of the following from the Interplay Client Installer Main Menu:

Clients > iNEWS Instinct

Clients > Assist

2. Install components from the following table:

n Assist and Instinct are 64-bit applications starting at Interplay v2.5. The installer pages install 
the 64-bit version of Avid Service Framework.

Interplay Assist and Avid Instinct must have ISIS client software installed on the same system. 
To use Assist or Instinct, you need to establish shared-storage credentials. This login happens 
automatically if your Windows login credentials (username and password) match those of a 
shared-storage account. If the accounts do not match, you need to connect through the Avid ISIS 
Client Manager. You do not need to mount workspaces unless you are sending Long GOP 
sequences to playback. For more information, see the Interplay | Assist ReadMe or the 
Interplay | Production ReadMe.

Installing Interplay | Access
You can install Interplay Access on any system that you want to use to work with the Interplay 
Engine. Besides installing Interplay Access, this installation also installs the Interplay 
Administrator.

See the following topics:

• “Installing Interplay Access on Windows” on page 64

• “Installing Interplay Access on a MacOS X System” on page 64

Component Description

Service Framework 
for Client

The installer automatically installs the components required for the 
application. When the system asks for a workgroup name, type the 
name of the workgroup you set up on the Interplay Engine. The name is 
case-sensitive.

Access Installs the Interplay Access and Interplay Administrator applications.

Assist Installs the Assist application software. For more information, see the 
Avid Interplay Assist User’s Guide.

iNEWS Instinct Installs the Avid Instinct application software. For more information, 
see the Avid Instinct User’s Guide.



Installing Interplay | Access

64

For information on using Avid Interplay Access and the Avid Interplay Administrator, see the 
following manuals:

• Interplay | Access User’s Guide

• Interplay | Engine and Interplay | Archive Engine Administration Guide

n To play streaming media in Interplay Access, the computer on which you are installing Interplay 
Access must have an audio device, such as an audio card or other audio hardware. 

Installing Interplay Access on Windows

To install Interplay Access software (Windows):

1. Select the following from the Interplay Client Installer Main Menu:

Clients > Access

2. Install components from the following table:

n The Service Framework is optional for an Interplay Access system.

For information about installing all Interplay components on an Avid editing system, see 
“Installing Software on Avid Editing Systems (Windows)” on page 66.

Installing Interplay Access on a MacOS X System

Interplay Access is supported on Macintosh® systems running Mac OS X. For more information 
about using Access with Mac OS X, see the Interplay | Access User’s Guide and the 
Interplay | Production ReadMe.

Apple Java for OS X: Interplay Access on Macintosh systems requires Apple Java v1.6 to be 
installed on the same system. This software is not automatically installed with Interplay Access. 
The Welcome screen of the Interplay Access installer describes which version of Apple Java is 
required and includes a URL for downloading the software.

Component Description

Service Framework 
for Client

(Option) The installer automatically installs the components required 
for the application. When the system asks for a workgroup name, type 
the name of the workgroup you set up on the Interplay Engine. The 
name is case-sensitive.

Access Installs the Interplay Access and Interplay Administrator applications.
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If you need to check which versions of Java 1.6 are installed on your system, you can obtain a list 
of v1.6 32-bit Java Virtual Machines (JVMs) by entering the following command in a terminal 
window:

/usr/libexec/java_home -V -v 1.6 -arch i386

The following command shows the full list of all JVMs:

/usr/libexec/java_home -V

To install Interplay Access on a Mac OS X system:

1. Open the Interplay Production Clients Installer.

The opening screen is displayed.

2. Double-click Install Interplay Access.

The first screen of the installer program is displayed.

n You cannot install Interplay Access until the correct version of Apple Java is installed. See the 
information earlier in this topic. 

3. Click Next and continue the installation.

 By default, Interplay Access is installed in the following folder:

Applications/Avid/Interplay Access
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To uninstall Interplay Access:

1. Double-click the following file:

Applications/Avid/Uninstallers/Interplay Access/Interplay Access Uninstaller.

2. Click Uninstall.

3. When the uninstallation is complete, click OK.

For information about installing all Interplay components on a Macintosh system or removing 
these components, see the following:

• “Installing Software on Avid Editing Systems (Macintosh)” on page 71

• “Removing Interplay Components from a Mac OS X System” on page 75

Installing Media Composer | Cloud Components

The Interplay Production Client Installer includes a page for installing Media Composer Cloud 
components (formerly Interplay Sphere). See the following documentation for detailed 
information:

• Media Composer | Cloud ReadMe

• Media Composer | Cloud Installation and Configuration Guide

For a link to all the Media Composer Cloud documentation, search for “Media Composer Cloud 
Documentation” on the Avid Knowledge Base.

Installing Software on Avid Editing Systems 
(Windows)

The Interplay Production Client Installer includes a page for installing Interplay components that 
are required to configure an Avid editing system in an Interplay environment.

You can install Interplay components on Windows systems running the following Avid editing 
applications:

• Media Composer | Software

• Media Composer | NewsCutter Option

• Media Composer | Symphony Option

These Avid editing applications have their own installers for the Avid editing application 
software. This section describes how to install components that are required for an Interplay 
environment.
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To install Interplay components on an Avid editing system (Windows):

1. Select the following from the Interplay Client Installer Main Menu:

Clients > Media Composer | Software Support

2. Install components from the following table:

If the editing system is on a different subnet from the system running the Service Framework 
Lookup service, you must use Unicast Discovery to allow the editor to locate the Lookup Server 
on that subnet. For more information, see “Connecting Systems Directly to the Lookup Service” 
on page 98.

n The Avid editing applications must have Avid ISIS Client Manager installed and configured to 
connect to shared storage.

Configuring an Avid Editing System in the Service Framework

After you complete the installation on each Avid editing system, verify that the Service 
Framework services are running on that system.

Component Description

Service Framework 
for Client

Installs the 64-bit Service Framework. The installer automatically 
installs the components required for the application. When the system 
asks for a workgroup name, type the name of the workgroup you set up 
on the Interplay Engine. The name is case-sensitive. See “Configuring 
an Avid Editing System in the Service Framework” on page 67.

Access Installs the Interplay Access and Interplay Administrator applications. 
See “Installing Interplay Access on Windows” on page 64.

Media Indexer Installs the 64-bit Media Indexer. You configure this Media Indexer to 
communicate with the Media Indexer monitoring shared storage. For 
more information, see “Connecting the Media Indexer on an Avid 
Editing System to the Media Indexer Monitoring Shared Storage” on 
page 69. You can also configure the Media Indexer to index your local 
drives. For more information, see “Configuring the Local Media 
Indexer to Index Local Drives” on page 70.

 Transfer Client (Option) Installs the 64-bit Interplay Transfer Client. Install this 
software to take advantage of Interplay Transfer features such as Send 
to Playback and workgroup to workgroup transfers. For information on 
configuring the Interplay Transfer client, see the Help for your Avid 
editing application or the Avid Interplay Transfer Setup and User’s 
Guide.
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To verify that the Service Framework services are running:

1. Click the Start button, and then select All Programs > Avid > Avid Service Framework > 
Avid Workgroup Properties.

The Avid Workgroup Properties window opens.

2. If your Workgroup name doesn’t appear in the Workgroup field, click the Edit button and 
type the name of the Workgroup.

n The Workgroup name can be different than the name of the computer that the Workgroup 
database is running on. This depends on how your Workgroup was originally configured. In this 
example, the Workgroup name is the same as the machine name.

If there is a green check mark next to the “Status” field, all services are running.

3. If the check mark is not green, click the Advanced button.

The Avid Interplay Services dialog box opens.

Check mark
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This dialog box allows you to view all services that are monitored by the Avid Service 
Framework. 

4. If necessary, select a service and click Start.

To verify that your system is listed in the Service Framework:

1. On any system that has the Avid Interplay Service Configuration tool installed, click the 
Start button, and then select All Programs > Avid > Avid Service Framework > Avid Service 
Configuration.

The Avid Service Configuration window opens.

2. See if the system you want to verify is listed.

3. If the system is in the list, then it is part of the Service Framework. You can optionally click 
the triangular opener next to the name and check which services are running on the system.

4. If the system you want to verify is not listed, it might be on a different subnet than the 
system running the Service Framework Lookup service. In that case, you need to use 
Unicast Discovery to allow the editor to locate the Lookup Server on the other subnet. See 
“Connecting Systems Directly to the Lookup Service” on page 98.

Connecting the Media Indexer on an Avid Editing System to the Media 
Indexer Monitoring Shared Storage

For information on connecting an Avid editing application to the Media Indexer monitoring 
shared storage, see “Configuring Media Indexer Servers and Clients” on page 51.
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Configuring the Local Media Indexer to Index Local Drives

To instruct Media Indexer to automatically recognize local drives:

1. Start the Avid editing application.

2. Select Tools > Media Creation.

The Media Creation window opens.

3. On the Drive Filtering and Indexing tab, click the “Auto-index local drives as they come 
online” button.

The local Media Indexer automatically configures Avid media files on your local drives.

n If you don’t want the Media indexer to automatically scan your local drives, deselect the 
Auto-index option.

4. (Option) Click Manual Storage Scan to start a scan.

5. (Option) Select one of the warning options. The warning occurs if the Media indexer has 
problems scanning files on the local drive.
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Installing Software on Avid Editing Systems 
(Macintosh)

The Interplay Production Client Installer for Macintosh includes Interplay components that are 
required to configure an Avid editing system in an Interplay environment.

You can install Interplay components on Macintosh OS X systems running the following Avid 
editing applications:

• Media Composer | Software

• Media Composer | Symphony Option

These Avid editing applications have their own installers for the Avid editing application 
software. This section describes how to install components that are required for an Interplay 
environment.

n The Avid editing applications must have Avid ISIS Client Manager installed and configured to 
connect to shared storage.

Component Description

Interplay Access Installs the Interplay Access and Interplay Administrator applications.

n Interplay Access requires Apple Java to be installed on the same 
system.

See “Installing Interplay Access on a MacOS X System” on page 64.

Interplay Transfer 
Client

(Option) Install this software to take advantage of Interplay Transfer 
features such as Send to Playback and workgroup to workgroup transfers. 
See “Installing Interplay Transfer Client on a Mac OS X System” on 
page 74.

For information on configuring the Interplay Transfer client, see the Help 
for your Avid editing application or the Avid Interplay Transfer Setup and 
User’s Guide.

Media Indexer Installs the Media Indexer. See “Installing Media Indexer on a MacOS X 
System” on page 72.

After installation, you configure this Media Indexer to communicate with 
the Media Indexer monitoring shared storage. For more information, see 
“Configuring Media Indexer Servers and Clients” on page 51 and “Using 
the Avid Service Framework on a Mac OS X System” on page 57.

Media Composer 
Cloud

For information about Media Composer Cloud, see “Installing Media 
Composer | Cloud Components” on page 66.
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Note the following:

- Through the Interplay Administrator, using either the application that is installed on the 
Macintosh client or one that is installed on another system in the workgroup. 
Double-click the Workgroup Properties icon or the Service Configuration icon in the 
main window of the Interplay Administrator.

- Through Interplay Access installed on the Macintosh client. Select View > Avid 
Workgroup Properties or View > Avid Service Configuration. 

• If you open Workgroup Properties on a Macintosh system, the Services tab does not include 
options to view the status of the Avid services running on the local computer, or to start, 
stop, restart, enable, or disable local services. For more information, see the 
Interplay | Production ReadMe.

• Avid editing applications running on Mac OS X systems require drive mapping for any 
workspaces that you use for reading or writing. For more information, see “Mounting 
Workspaces as Drives: Lettered versus Letterless” on page 91.

• You cannot use Interplay Media Services from an Avid editing application running on a Mac 
OS X system. Most Interplay Media Services are available from Interplay Access on a Mac 
OS X system.

Installing Media Indexer on a MacOS X System

To install Media Indexer on a Mac OS X system:

1. Open the Interplay Production Clients Installer.

The opening screen is displayed.
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2. Double-click Install Media Indexer

A message asks if you want to continue the installation.

3. Click Continue.

The first screen of the installer program is displayed.

4. Click Continue.

5. When prompted, enter a user name and password for an account that is allowed to install 
software.

6. When prompted, restart the system.

7. After Media Indexer is installed, configure it to communicate with the Media Indexer 
running monitoring shared storage. See “Configuring Media Indexer Servers and Clients” on 
page 51. 

You can also configure the Media Indexer to index your local drives. For more information, 
see “Configuring the Local Media Indexer to Index Local Drives” on page 70.

To uninstall Media Indexer, see “Uninstalling Media Indexer from a Mac OS X System” on 
page 74.
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Installing Interplay Transfer Client on a Mac OS X System

To install the Interplay Transfer client on a Mac OS X system:

1. Open the Interplay Production Clients Installer.

The opening screen is displayed.

2. Double-click “Install Interplay Transfer.”

The first screen of the installer program is displayed.

3. Click Next and continue the installation. When prompted, enter a user name and password 
for an account that is allowed to install software.

The following file is installed: 

/Library/Application Support/Avid/xfermgraphi.bundle

There is no uninstaller for the Transfer Client, so if you need to uninstall the Transfer Client, 
delete the installed file.

Uninstalling Media Indexer from a Mac OS X System

To uninstall Media Indexer:

1. (Option) Stop Media Indexer (see “Stopping and Starting Media Indexer on a MacOS X 
System” on page 75).

2. Open a Terminal window (select Applications > Utilities > Terminal).
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3. At the prompt, type the following and press Return:

cd /Applications/Avid_Uninstallers/Media\ Indexer

4. Type the following and press Return:

sudo ./AvidMediaIndexerUninstaller.sh

Media Indexer is uninstalled.

n If you close the terminal window without uninstalling the program, you can no longer use the 
terminal window. Workaround: Restart the Macintosh system.

Stopping and Starting Media Indexer on a MacOS X System

To stop Media Indexer:

1. Open a Terminal window (select Applications > Utilities > Terminal).

2. At the prompt, type the following and press Return:

cd /Applications/Avid/Media\ Indexer/bin

3. Type the following and press Return:

sudo ./mi.sh remove

Media Indexer is stopped. To restart it, type the following and press Return:

sudo ./mi.sh install

Removing Interplay Components from a Mac OS X System

To remove all Interplay components from a MacOS X system, complete the following 
procedures.

To uninstall Interplay Access:

1. Double-click the following file:

Applications/Avid/Uninstallers/Interplay Access/Interplay Access Uninstaller.

2. Click Uninstall.

3. When the uninstallation is complete, click OK.

To uninstall Media Indexer:

1. (Option) Stop Media Indexer (see “Stopping and Starting Media Indexer on a MacOS X 
System” on page 75).

2. Open a Terminal window (select Applications > Utilities > Terminal).

3. At the prompt, type the following and press Return:

cd /Applications/Avid_Uninstallers/Media\ Indexer
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4. Type the following and press Return:

sudo ./AvidMediaIndexerUninstaller.sh

Media Indexer is uninstalled.

n If you close the terminal window without uninstalling the program, you can no longer use the 
terminal window. Workaround: Restart the Macintosh system.

To uninstall Transfer Manager:

t Delete the following file:

/Library/Application Support/Avid/xfermgraphi.bundle



4 Installing Optional Software

You can run individual optional installers as described in the following sections:

• Performing a Custom Install of the Service Framework Software

• Installing Interplay | Access or Interplay | Production Services and Transfer Status

• Browsing the Interplay Installer Folders

Performing a Custom Install of the Service 
Framework Software

The Service Framework is used to monitor and configure the Media Indexer and the optional 
Interplay Auto Archive service. It also lets you monitor the health of other components that have 
the Service Framework installed and to view logs on the systems. For more information see the 
Avid Service Framework User’s Guide.

You install different components of the Service Framework software on different systems in the 
Interplay Production environment. The individual installation windows automatically install all 
the components needed for the clients and servers. This installer lets you select and install 
specific components.

To install the 64-bit version of Service Framework software:

1. Select the following from the Interplay Server Installer Main Menu or the Interplay Client 
Installer Main Menu:

Individual Optional Installers

The Optional Installers window opens.
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2. Click Service Framework (custom).

The Introduction window opens.

3. Click Next.

The Choose Install Folder window opens.

4. Accept the default values and click Next.

The Join a Workgroup window opens.
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5. Type the name of your Workgroup and click Next.

c Use the same Workgroup name on all Interplay clients. You can either use the default value 
or type a name for your Workgroup. The name is case sensitive.

c If you are updating the Service Framework software, the installer remembers the last 
installed value. If the workgroup name was changed after the install, the installer will not 
be aware of the change.

The Options window opens.
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6. Select the type of Framework installation you wish to make. 

7. Click Next.

The Custom Setup dialog box opens. This dialog box displays the components that will be 
installed. 

The following illustration shows the default components for a Framework Client install.
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If this is not the correct set of components, do one of the following:

t Click the Back button and select a different group.

t Select or deselect components from the list in the Custom Setup dialog box.

n Don’t add components that you don’t need. This can affect system performance.

8. Click Next and follow the installation instructions to complete the installation.

The installer might require that you restart your system to complete the installation.

Verifying that the Service Framework Services Are Running

You must perform these steps on each system running the Service Framework Services.

To verify that the Service Framework Services are running:

1. Click the Start button, and then select All Programs > Avid > Service Framework > 
Avid Workgroup Properties.

The Avid Workgroup Properties window opens.
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If there is a green check mark next to the “Status” field, all services are running.

2. To view the services, click the Advanced button. 

The Avid Interplay Services dialog box opens.

This dialog box lets you view all services that are monitored by the Service Framework. 

3. If necessary, select a service and click Start.

Disabling Framework Services

Depending on the system you install the Service Framework Services on, you might need to 
disable some services. 

To disable a service:

1. Click the Start button, and then select All Programs > Avid > Service Framework > 
Avid Workgroup Properties.

The Avid Workgroup Properties window opens.

2. Click the Advanced button. 

The Avid Interplay Services dialog box opens.
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3. Select the service you want to disable and click Stop.

4. After the service stops, click the Disable button to disable the service.

5. Click Exit to close the Avid Interplay Services dialog box.

6. Click OK to close the Avid Workgroup Properties window.

Installing Interplay | Access or Interplay | Production 
Services and Transfer Status

You can install Interplay Access or the Interplay Production Services and Transfer Status tool on 
any qualified Windows system running in your Interplay environment. This lets you run these 
applications without affecting the work on other systems such as a server or an Avid editing 
system.

To install the Interplay Access or Interplay Production Services and Transfer Status 
software:

1. Select the following from the Interplay Server Installer Main Menu or the Interplay Client 
Installer Main Menu:

Individual Optional Installers

2. Install components from the following table:

Component Description

Access Installs the Interplay Access and Interplay Administrator applications. 
For more information, see “Installing Interplay | Access” on page 63.



Browsing the Interplay Installer Folders

84

Browsing the Interplay Installer Folders
To browse the Installer Folders:

1. Select the following from the Interplay Server Installer Main Menu or the Interplay Client 
Installer Main Menu:.

Individual Optional Installers.

2. Click “Browse all installers.” 

3. (Option) Select any of the installers from the Installers folder, and perform a 
custom installation.

Interplay Production 
Services and Transfer 
Status (formerly 
Media Services and 
Transfer Status)

This lets you view the status of Interplay Transfer and Interplay 
Production Services jobs. 

Component Description



5 Installing and Configuring an Interplay 
Archive Engine

The following topics are covered in this chapter:

• Installing the Interplay Archive Engine Software

• Setting Up a Failover System

• Updating the Interplay Archive Engine Software

For more details on the Interplay Archive Engine, see the Interplay | Media Services Setup and 
User’s Guide.

Installing the Interplay Archive Engine Software
You need to install the following software on the Interplay Archive Engine server:

• Interplay Archive Engine

• Interplay Access

• FlashNet Client software (see Installing the FlashNet Client Software)

Additionally, you must install the Interplay Archive Provider on a separate server. See “Installing 
the Interplay Archive Provider Software” on page 87.

The Interplay Archive Engine installation is very similar to the Interplay Engine installation. The 
following are the main differences:

• It is not necessary to split the database because it is not possible to archive file assets.

• The database is called AvidAM.

• There is no temporary license key. On the Interplay Engine it is possible to connect one 
Access client to the engine when no permanent license is loaded. This is not possible on the 
Interplay Archive Engine. It is necessary to load a license before you are able to connect 
with Interplay Access. It is also necessary to load the license before you create the database. 
See “Managing Licenses” in the Interplay | Engine and Interplay | Archive Engine 
Administration Guide for instructions. 

• The AvidAM database has fewer predefined folders than the AvidWG database.
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The Interplay Archive Engine maintains a database that can be accessed through Interplay 
Access and the Interplay Administrator tool. For information on configuring the server, see the 
Interplay | Engine and Interplay | Archive Engine Administration Guide.

For information on using Interplay Access on an Archive database, or archiving from an Avid 
editing application, see the Interplay | Media Services Setup and User’s Guide. 

To install the Interplay Archive Engine software:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Interplay Archive Engine

The Install Avid Interplay Archive Engine window opens. 

2. Click Avid Interplay Archive to install the Interplay Archive Engine on the system. See 
“Installing the Interplay | Engine Software” on page 31.

3. Click Avid Interplay Access to install Interplay Access on the system. See “Installing 
Interplay | Access” on page 41.

Installing the FlashNet Client Software

Typically your Software Generation Limited (SGL) representative installs and configures the 
FlashNet client software when he or she configures the rest of the archiving system. For 
information on using the FlashNet client, see the documentation provided by your SGL 
representative.

SGL Direct Connect to Shared Storage

Avid Interplay v2.6 and v2.7 support SGL FlashNet v6.4.x. This version of SGL FlashNet allows 
the FlashNet server to directly connect to an Avid ISIS shared-storage system through a 1-GB 
connection, dual-connected on the same subnet to the ISIS System Director in Zone 1. SGL 
FlashNet v6.4.x is qualified with Avid ISIS 7000 systems. ISIS v4.0 or later client software must 
be installed on the FlashNet server.

This configuration results in a significant performance increase for Interplay archive and restore 
operations.

Your SGL representative installs and configures the FlashNet client software on the Archive 
Provider. After installing the FlashNet client on the provider, the representative needs to create a 
registry key, as follows:

1. In a Command Prompt window, type regedit to open the Registry Editor.

2. Locate and select the following registry key: 
\HKEY_LOCAL_MACHINE\SOFTWARE\Software 
Generation\Wow6432Node\FlashNet6.
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3. Select Edit > New > String Value, name the new registry key “DETDropClient” and enter 1 
as the value. (0 specifies disabled).

4. Restart the FlashNet socket listener service.

5. Restart the provider services.

SGL FlashNet v6.4.x includes support for Simplified Chinese, which is qualified for use with 
Interplay Archive and Interplay Restore services.

Installing the Interplay Archive Provider Software

You typically install the Interplay Archive Provider software on a separate server for 
performance reasons. Install the Interplay Archive Provider from the Avid Interplay Media 
Services page of the Interplay Installer. See “Installing Software on the Production Services and 
Production Services Provider Servers” on page 42.

n The Interplay Archive Provider requires an Interplay Media Services application key (also 
referred to as a dongle) with the Archive and Restore option.

To install the Interplay Archive Provider and Auto Archive software:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Interplay Production Services > Install Local Workflow Support > Avid 
Interplay Archive Provider

2. (Option) Also install Avid Interplay Auto Archive.

3. Install the Service Framework client software. Use the installer on the following page: 
Servers > Avid Interplay Media Services. See “Selecting the 32-Bit or 64-Bit Version of 
Avid Service Framework” on page 29.

For information on setting up the Interplay Archive provider and Interplay Auto Archive, see 
the Interplay | Media Services Setup and User’s Guide.

Setting Up a Failover System
You can configure the Interplay Archive Engine in a cluster configuration for automatic failover 
protection. For details on setting up the system, see the Interplay | Engine Failover Guide or 
Interplay | Engine Failover Guide for AS3000 Servers on the Knowledge Base.



Updating the Interplay Archive Engine Software

88

Updating the Interplay Archive Engine Software
When you update the Interplay Archive Engine, do not delete the software using the 
Add/Remove Programs or any other mechanism for deleting software. If you delete the software, 
the system deletes the folder structure in place at the time of the update. To update the software, 
start the Archive Engine installer on the Interplay Servers Installer and follow the installation 
instructions. The system updates the software without performing a remove operation. This 
preserves the folder structure.



6 Additional Configuration Topics

This chapter covers the following topics:

• Using Antivirus Software in an Interplay | Production Environment

• Troubleshooting Firewalls and Interplay | Production

• Integration of Journal Data into the Database

• Mounting Workspaces as Drives: Lettered versus Letterless

• Using Time Synchronization in an Interplay | Production Environment

• Installing the Lookup Service on a Separate Server

• Connecting Systems Directly to the Lookup Service

Using Antivirus Software in an Interplay | Production 
Environment

Interplay v2.x supports the Antivirus and Spyware components of Symantec™ Endpoint v12.1 on 
servers and clients. 

Interplay does not support the following components:

• Proactive Threat Protection

• Network Threat Protection

The following Knowledge Base article describes how to install and configure Symantec 
Endpoint v12.1 in an Interplay environment:

Using Antivirus Software in an Interplay Environment, Support for Symantec Endpoint v12.1
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Troubleshooting Firewalls and Interplay | Production

Firewalls on client machines interfere with Interplay Production’s TCP/IP communications.

Symptoms

• The list of servers does not appear, for example, when you are connecting to a new database.

• Connection establishment to the server fails.

Cause

These problems can be caused by personal firewalls installed on the client machine. A typical 
example for such a firewall is ZoneAlarm® from ZoneLabs™or the Windows 7 firewall. 

These applications intercept all outgoing and incoming network traffic and decide whether to let 
the traffic go through or block it. The effect is that applications like Interplay Production fail to 
connect to their servers.

Typically when the client looks for available Interplay Engines in the network, no servers can be 
retrieved. When the client is looking for servers, a UDP broadcast is sent out on port 8321.

Solution

Usually these personal firewalls can be configured to allow all network traffic for specific 
applications. This should be done for Interplay Production locally or for Internet access 
depending on which servers Interplay Production should connect to.

For information about ports used by Interplay Production, see “Interplay | Production Port 
Usage” on page 132.

Integration of Journal Data into the Database

The Interplay Engine database consists of a core database store and a single permanent journal 
file. The journal file holds the current binary data changes that are not yet written through to the 
core database. The core database and the journal file are both contained in the _Database folder. 

n Prior to Interplay version 2.1, the Interplay Engine created multiple journal files, and it was 
important for administrators to monitor the number of journal files created. This monitoring is 
not needed for Interplay version 2.1 and higher.

Both core database and journal file are used for engine operations, like ingest, searching, or 
deletion. The integration of data in the journal file into the core database is happening constantly 
in a background thread.
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The journal file can grow in size when the Interplay Engine is extremely busy (for example, 
during a database schema upgrade), but will eventually shrink back to its default size (8 MB for 
the CCS database _InternalData, 32 MB for AvidWG and AvidAM). Journal integration is no 
longer suspended when a backup is performed. Therefore, journal data does not accumulate 
when a backup is running.

If a Severe Error Occurs

If a severe error occurs during integration of journal data into the core database, the Interplay 
Engine suspends the integration. Such severe error cases include:

• Failure of integration of journal data into the core database

• Failure to read/write from the journal file 

• Failure to do deletes in the streamed property store (this is a central step in the journal 
integration)

Usually in such cases, the Interplay Engine rejects all further write operations and reports an 
error code in the server log and to the clients trying to perform write operations. There are cases 
where the Interplay Engine can continue operating and adding data to the journal file, but this 
data is not integrated into the core database.

Journal integration relies on disk access to the _Database folder at all times.

There is one point in time when the engine relies on the journal integration to be finished (at all 
other times it is done in a parallel thread). This one point is when a database is loaded, for 
example, when a database is brought up, a failover was triggered, or a cluster was taken offline 
and back online. At this point, when the database is loaded, the journal integration is enforced. 
Integration needs to go through and finish so that the database can be cleared and go online (be 
accessible by clients).

Mounting Workspaces as Drives: Lettered versus 
Letterless

Avid editing applications, Interplay Assist, and Avid Instinct require Avid shared storage client 
software to function as clients in an Interplay Production workgroup. Explicit mounting of 
workspaces as drives might or might not be necessary, depending on your particular workflow. In 
general, there is no harm in mounting the workspaces that you need. 
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The following information applies to mounting workspaces in an Interplay environment:

• Media Indexers that monitor shared storage must use UNC (letterless) drive mapping. See 
“Using UNC Drive Mapping on Interplay ISIS” on page 50.

• Avid editing applications require login to the Avid ISIS Client Manager to read from a 
workspace. 

If your Windows username and password exactly match the Avid shared storage username 
and password, login is automatic. If your Windows username and password do not match, 
you need to log in through the Client Manager.

Drive mappings for read operations are not required except on Mac OS X systems.

n Avid editing applications running on Mac OS X systems require drive mapping for any 
workspaces that you use for reading or writing. 

• In addition to a valid login, Avid editing applications must use drive mapping for any 
workspaces that you write to.

For Windows systems, you must use lettered drive mapping. If you do not use lettered drive 
mapping you cannot select a workspace in the Volume menu in the Capture tool, in the 
Media Creation tool, or in the Import dialog box.

• In addition to a valid login, Avid editing applications, Avid Instinct, and Interplay Assist 
require the following to use the Send to Playback feature:

- A workspace to which you have write access specified in the Editor Database Settings 
view of the Interplay Administrator, in the option “Media Creation Workspace.” 

When you send to playback, the application searches the workspaces to which you have 
write access and writes a temporary file to a Temp folder at the top level of the 
workspace with the most free storage space.

n On Interplay Assist or Avid Instinct, if your workflow includes sending Long GOP (XDCAM HD 
or XDCAM EX) media to playback, you need to mount at least one of the workspaces to which 
you have write access as a lettered drive. If you do not have at least one workspace mounted as 
lettered drive, you get an error message “Unable to find a shared storage volume for media 
transfer.” 

• To use Interplay Transcode and other Media Services, you must mount at least one 
workspace for each shared-storage system that you use for reading and writing on the 
provider system. You can mount the workspace as a UNC drive or a lettered drive.In most 
cases, you do not need to mount each workspace that you use, but there is no harm in doing 
so. For Interplay Transcode, if you use lettered drives, you must mount the target workspace.
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Note the following:

- Starting with version 2.6, the Interplay Transcode service and the STP Encode service 
require you to choose during installation how ISIS workspaces are mounted: by drive 
letter or by UNC path. For multiple ISIS workgroups, select UNC paths if the number of 
workspaces required for the client exceeds the available drive letters. Mount the 
workspaces before you start the service.

For more information on mounting workspaces as drives, see the Avid ISIS Client Manager 
Help.

Using Time Synchronization in an 
Interplay | Production Environment

The following two time sync methods are commonly used in Interplay Production environments:

• Network Time Protocol (NTP): For detailed information on this method, search for A Guide 
to Time Synchronisation for Avid Interplay Systems on the Avid Knowledge Base. This 
document provides a guide for synchronizing many Avid products.

• Interplay Time Synchronization provided with the Avid Service Framework. This method is 
described in the following section.

Using the Avid Service Framework Time Sync Feature

n Slave Time Sync services are only useful to set the local PC clock. If you aren’t using your slave 
Time Sync to set the local PC clock, you can disable the Time Sync service on that computer.

The Avid Time Synchronization Service enables time synchronization between different 
machines in a workgroup. The Time Synchronization Service can operate in either Master mode 
or Slave mode. In Master mode, the service retrieves a reference time from a configured time 
source and redistributes it to the Slave services within the workgroup. The time source can be the 
local PC clock, an NTP server, or an Adrienne timecode card installed in the server. If multiple 
Time Synchronization Services are configured as Master, they coordinate among themselves and 
identify one Primary service to distribute the time notifications (the others are in Backup mode 
and silent until a Primary fails, at which time one of the Backups takes over). In Slave mode, the 
Time Synchronization Service listens for time notifications from the workgroup and (optionally) 
sets the local PC clock to match.



Using Time Synchronization in an Interplay | Production Environment

94

The following are the three typical ways of implementing Time Synchronization in an Interplay 
environment:

• In Interplay environments that use Interplay Capture, a Capture system is usually designated 
as the Time Sync master. The Capture system can have an Adrienne card. Install the Service 
Framework Time Synchronization service on the Capture system and configure it as a Time 
Sync master.

• If you don’t use an Interplay Capture system, do one of the following:

- Designate another system with an Adrienne card as the Time Sync master. Install the 
Service Framework Time Synchronization service on this system and configure it as a 
Time Sync master.

- Use an NTP server for Time Sync reference. Install the Service Framework Time 
Synchronization service on a system on the network that does not need to be shut down 
frequently and configure the service as a master. When you configure the master, point 
to the NTP service for time sync.

- Designate any system that rarely has to be shut down as the Time Sync master and set 
the Time sync reference to the internal PC clock on that system.

It is important to use only one time synchronism mechanism to set the local PC clocks in the 
Interplay environment. If a Time Synchronization Slave service is configured to set the local PC 
clock and it detects that some other mechanism (such as Windows 32 Time Services) changes the 
local clock, the Time Sync Slave service disables itself to avoid the local clock from jumping 
back and forth. The Time Sync slave also posts a Warning in the Health Monitor.

When you install the Time Synchronization service on a system it runs as a Time Sync slave by 
default. For information on how to configure a Time Sync master, see “Configuring the Time 
Sync Master” on page 94.

Time Sync and Log Files

All “Framework enabled” services that produce log files listen to the timestamps sent out by a 
Time Sync Master. They do this to produce a “Sync Time” field in the log files. So, even if the 
local PC clocks on all the computers do not match, the “Sync Time” field in the log files is 
always in sync across all the log files on all the machines.

Configuring the Time Sync Master

To configure the Time Sync Master:

1. Install the following Service Framework components on the system that will be used as the 
master:

- Core Components

- Configuration Utility 
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- Diagnostic Log Viewer

- Health Viewer

- Machine Monitor

- Time Synchronization 

2. On any system that has the Interplay Configuration Utility installed, click the Start button 
and select All Programs > Avid > Service Framework > Avid Interplay Service 
Configuration.

The Interplay Service Configuration window opens.

3. Select the system that will be the Time Sync master and click Avid Time Synchronization. 

The Time Synchronization Settings window opens.

4. Select options as described in the following table.

Time Synchronization Settings

Options Description

Time Stamp Interval (in 
seconds)

Determines how often the master sends out time stamp information. The 
default is 10 seconds.
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Installing the Lookup Service on a Separate Server

If you have more than 10 clients in your Avid Service Framework environment (including Avid 
editing applications, Avid Instinct, and Avid Assist), Avid strongly recommends that you put the 
Service Framework Lookup Service on a separate server such as a General Purpose Server. For 
redundancy, you may decide to set up two separate servers running the Lookup Service. The 
following section describes how to install the Lookup Service on a separate server.

To install the Lookup Service on a separate server:

1. Select the following from the Interplay Server Installer Main Menu:

Individual Optional Installers

2. Double-click Avid Service Framework Custom.

3. Follow the onscreen instructions and watch for the following items:

a. Enter your Workgroup name in the Workgroup Name window.

b. In the Options window, select “Typical Avid Interplay Server Install”.

Configuring Lookup Servers

After you complete the installation, use the Avid Interplay Service Configuration tool to check 
that the Lookup Service is not running on other Interplay Servers, particularly on Media Indexer 
servers.You can use the Avid Service Framework Workgroup Properties tool to disable the 
service on other servers.

Get Time Sync reference 
from the local PC clock

Select if you are simply using the local PC clock of one system on your 
network for time sync reference.

Get Time Sync Reference 
from an NTP server

Select when you are pointing to an NTP server on your network for time 
sync reference. 

n The NTP server does not need Service Framework software installed 
on it.

Get Time Sync reference 
from an internal Time Code 
Reader

Select when the Time Sync master system has an Adrienne timecode card.

n Interplay Capture systems can have an Adrienne card.

Time Synchronization Settings

Options Description
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For best results, connect each system running the Service Framework to the Lookup Service 
manually via the Workgroup Properties tool. This technique is called Unicast Discovery and is 
described in “Connecting Systems Directly to the Lookup Service” on page 98. Unicast 
Discovery ensures a direct connection to the Lookup Service.

Technically there is no need for Unicast Discovery on a local subnet that contains a Lookup 
Service. Unicast Discovery ensures connection to the Lookup Service but takes extra time to 
configure on a large workgroup since you have to make the connection manually on each system.

n The Avid Service Framework installer has an optional service named Multicast Repeater that 
can be used to communicate across subnets. Multicast Repeater is no longer recommended 
because it relies on a single point of communication across the subnets.

When working with multiple subnets, use Unicast Discovery on the remote subnets. Unicast 
Discovery allows for fast registration and discovery operations for systems on remote subnets.

n If you use more than one Lookup Services, use Unicast Discovery to connect to both Lookup 
Services on each machine.

Interplay System Configuration Service

Use the Interplay Service Configuration tool to check for occurrences of the System 
Configuration Service on any of your Interplay servers. This service should only run on the 
systems that contain the Lookup Service. Use the Workgroup Properties tool to disable the 
service on any other servers.

n The System Configuration service is different from the Service Configuration tool. The Service 
Configuration service runs the Interplay Service Configuration tool and can be installed on any 
system running the Service Framework.

Configuring Lookup Servers on Avid ISIS

Avid recommends that you single connect the LUS using the following guidelines:

• Single connect a LUS to each VLAN. In this case, use Unicast Discovery as follows:

- On each LUS system, open the Workgroup Properties tool, click the Lookup tab, and 
enter the fully qualified domain name of the other LUS system.

- On each client, open the Workgroup Properties tool and specify the fully qualified 
domain name of both LUS systems.

• The Interplay router needs to have a route configured between the two VLANs.

n Do not dual connect a LUS. To achieve redundancy, it is better to single connect a separate LUS 
to each VLAN.
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n There is no load balancing between Lookup Services. If you have two LUS systems they operate 
independently of each other. All Framework services register with both services. To ensure 
connectivity between subnets, use Unicast Discovery to connect all of your clients to both LUS.

Connecting Systems Directly to the Lookup Service

For systems on remote subnets, Avid recommends that you connect directly to the Lookup 
service using a technique known as Unicast Discovery. 

The main drawback to using the Unicast Discovery connection method is that if there are 
multiple systems running the lookup service, you should connect to each one. This can take a lot 
of configuration time in a large installation. If you don’t connect to all of the Lookup service 
systems, if the one you are connected to goes down you lose your connection to the Service 
Framework.

To directly connect a system to a Lookup service:

1. Determine the fully qualified domain name of the system running the Lookup service. For 
example, the following defines the domain name of the server named DocWG:

docwg.global.avidww.com

2. On the system on the remote subnet, click the Start button, and then select All Programs > 
Avid > Service Framework > Avid Workgroup Properties.

3. Click the Lookup tab.

4. Select the Workgroup that you want to connect to and click Add in the Lookup services 
window.

n If the name of the workgroup that you need does not appear in the Workgroup area, click the Add 
button and add the entry. Remember that the name is case sensitive.

5. In the Lookup services area, type in the fully qualified domain name of the system running 
the Lookup service.

6. Leave the port value at the default 4160.

7. Click Expected and click OK.

8. The domain name appears in the Lookup services area, as shown in the following example.



Connecting Systems Directly to the Lookup Service

99

n In this example, the name of the workgroup is the same as the name of the machine running the 
Lookup service.

9. Click Apply and click OK.



7 Workgroups with Multiple ISIS Systems

The following topics describe support for multiple ISIS systems in a single workgroup: 

• Understanding Multiple ISIS Workgroups

• Check List for Adding Multiple ISIS Systems to a Workgroup

• Requirements for Multiple ISIS Workgroups

• Adding Remote ISIS Systems to ISIS Client Software

• Adding Remote ISIS Systems in the Interplay Administrator

• Configuring Media Indexer for Additional ISIS Systems

• Mounting ISIS Workspaces as UNC Paths

• Working with Media Services and Interplay Transfer in a Multiple ISIS Workgroup

Understanding Multiple ISIS Workgroups
Interplay v2.6 introduced support for up to three ISIS shared-storage systems managed by a 
single Interplay Engine and configured in a single workgroup. Using multiple ISIS systems 
allows you to expand available storage for your Interplay Production workgroup. 

Previous versions of Interplay limited a workgroup to one shared-storage system. Interplay v2.6 
and later allows you to integrate one or two additional ISIS shared-storage systems, for a total of 
three.

Interplay Move v2.6 and later can be used for high-speed transport of media between multiple 
ISIS systems. For more information, see “Working with Media Services and Interplay Transfer 
in a Multiple ISIS Workgroup” on page 111.

A 10-Gb switch and 10-GB connections are recommended as high-bandwidth links between the 
ISIS systems. For more information, see “Requirements for Multiple ISIS Workgroups” on 
page 105 and the following configuration example.
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Local ISIS System and Remote ISIS Systems

An Interplay workgroup requires one ISIS shared-storage system that shares the same subnet 
with the Interplay workgroup. This ISIS system is considered the local system. You can use the 
ISIS client software on the Interplay Engine to add an ISIS system that exists on a different 
subnet. This ISIS system is considered a remote system.

The following illustration shows an example of a multiple ISIS configuration. The local ISIS 
system is an ISIS 7000, dual-connected to an Avid network switch through subnets VLAN 10 
and VLAN 20 (Zones 1 and 2). The remote ISIS system is an ISIS 5000, single-connected 
through VLAN 30, a different subnet on the same switch (Zone 3). A Media Indexer is 
dual-connected to the same subnets as the Interplay Engine and local ISIS system. This Media 
Indexer is configured to scan both the local ISIS system and the remote ISIS system.

n This illustration shows one example of an Interplay network configuration. Other configurations 
are also supported if each ISIS System Director is in its own Zone 3 subnet.

LEGEND

Multiple ISIS Configuration

Media Indexer 1 GB Ethernet Connection

ISIS 7000 System Director

 ISIS Client Software

ISIS 7000 Drive Arrays
ISIS 5000
System Director and Drive Arrays

 Interplay Engine
 ISIS Client Software

10 Gb Ethernet Connection

VLAN 10 VLAN 20 VLAN 30

Local System Remote System
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Limitations

• Each workspace name in the workgroup must be unique. There can be no duplicate 
workspace names across the multiple ISIS systems.

This restriction is especially important when using Interplay Access for tasks that require 
reference to a workspace, such as delete and search. In those parts of Interplay Access that 
require a workspace name, you cannot specify a shared-storage server name, only a 
workspace name.

You can view complete path for files, including the shared-storage server and workspace, in 
the File Locations tab of the Object Inspector.

• The Interplay Media Indexer application must run on an AS3000 server in order to monitor 
multiple ISIS systems. The total number of files that the Media Indexer can monitor sets the 
limit for the number of files supported in a multiple ISIS workgroup. See the Interplay 
Readme for the supported values. You can use the Media Indexer web-based user interface 
to view the current file count. The value (Files) is displayed in the Statistics window as 
shown in the following illustration.

For more information, see the Interplay | Production Best Practices Guide.

• There can be only one copy of a media file in the entire workgroup. The Copy service is not 
supported for copying assets from one ISIS system to another within the same workgroup.

• Adding additional ISIS systems does not increase the number of ISIS clients that are 
supported in the workgroup.

Avid Editing Systems Support

Users of Avid editing applications (NewsCutter, Media Composer), Interplay Assist, and Avid 
Instinct can edit using media from any ISIS system to which they have access. On each system, 
the ISIS client software must be configured for additional ISIS systems. See “Adding Remote 
ISIS Systems to ISIS Client Software” on page 106. 
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Playback of a sequence with clips from multiple ISIS 7500 - 7000 systems, multiple ISIS 5500 - 
5000 systems, or a combination of the two systems is qualified. Playback of a sequence with 
clips from an ISIS 2500 - 2000 and an ISIS 5500 - 5000 or ISIS 7500 - 7000 is not qualified.

Media Creation Workspaces

The Media Creation Workspace setting in the Interplay Administrator sets the workspace used 
for media clips created by Instinct and Assist users, such as voice-over recordings and clips 
created during send-to-playback operations. Beginning with Interplay v2.6, the displayed 
workspaces include the hostname of the shared-storage server in a UNC path. All existing 
settings are retained as part of an upgrade to v2.6 or later and you do not need to change them.

For a multiple ISIS workgroup, the Media Creation Workspace setting is affected in the 
following ways:

• If you do not list shared-storage servers for Avid ISIS Authentication in the User 
Authentication view of the Interplay Administrator, the Media Creation setting shows 
accessible workspaces for all ISIS systems that are configured through the ISIS client on the 
Interplay Engine. 

• If you list shared-storage servers for Avid ISIS Authentication in the User Authentication 
view of the Interplay Administrator, the servers that you specify determine which 
workspaces are displayed. This occurs whether or not ISIS user authentication is activated. 
For example, if you specify SysDirector_A, only workspaces on SysDirector_A are listed. If 
you specify SysDirector_A and SysDirector_B, workspaces on both systems are listed. See 
“Adding Remote ISIS Systems in the Interplay Administrator” on page 109.

n The UNC paths are not displayed until the first time you set or change the Media Creation 
Workspace setting.

AirSpeed Server Support

AirSpeed Multi Stream and AirSpeed 5000 server support: 

• Simultaneous send-to-playback operations from multiple ISIS systems are supported (v1.8.x 
and later). 

• Recording to a remote ISIS system is not supported.

AirSpeed Classic is not supported.
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Check List for Adding Multiple ISIS Systems to a 
Workgroup

Use this checklist to add one or two remote ISIS systems to a workgroup that already includes a 
local ISIS system.

Task Section Reference

 Review the requirements for adding a remote 
ISIS system.

“Requirements for Multiple ISIS Workgroups” 
on page 105

 Integrate the additional ISIS system or 
systems into the network.

“Understanding Multiple ISIS Workgroups” on 
page 100, Avid Products and Network Site 
Preparation Guide, and the Setup Guide for the 
ISIS system.

 Upgrade to Interplay v2.6 or later. Interplay | Production ReadMe

 When upgrading Interplay Transcode and STP 
Encode, select the option to mount 
shared-storage drives as UNC paths.

“Mounting ISIS Workspaces as UNC Paths” on 
page 111

 Create accounts for the Server Execution User 
and Interplay users on each additional ISIS 
system.

Avid ISIS documentation

 Add each additional ISIS system to the ISIS 
Client Manager on the Interplay Engine.

“Adding Remote ISIS Systems to ISIS Client 
Software” on page 106.

 For Unity authentication, specify the server 
name of each additional ISIS system in the 
Interplay Administrator.

“Adding Remote ISIS Systems in the Interplay 
Administrator” on page 109.

 Configure Media Indexer for each additional 
ISIS system.

“Configuring Media Indexer for Additional ISIS 
Systems” on page 108 and “Configuring Media 
Indexer Servers and Clients” on page 51. 
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Requirements for Multiple ISIS Workgroups
Avid ISIS Hardware and Software Configurations

Currently up to three ISIS shared-storage systems are supported for a single workgroup. The 
following models are supported, in any combination:

• ISIS 2500 - 2000 systems

• ISIS 5500 - 5000 systems

• ISIS 7500 - 7000 systems

Avid ISIS v4.0 or later server and client software is required.

Each additional ISIS System Director must be in its own Zone 3 subnet (see “Understanding 
Multiple ISIS Workgroups” on page 100).

Avid recommends that all ISIS systems are connected through a 10-Gb network. The network 
topology should be determined by the site requirements.

Interplay Software

All components in the workgroup must be running Interplay version 2.6 or later.

Accounts

The Interplay workgroup and both ISIS systems must include matching user accounts as follows:

• Server Execution User: An account with a user name and password identical to the Server 
Execution User must exist on the ISIS system. This account must have read/write access to 
the Avid shared storage workspaces that contain media. Use the Avid ISIS Administration 
tool to create this account.

• Interplay and ISIS users: Accounts with identical user names and passwords must exist on 
the Interplay system and the ISIS system. 

- The ISIS user account must have read/write privileges on the workspaces you want to 
move from and move to.

- The matching Interplay user account must have read/write privileges on the folders you 
want to move from and move to. 

Media Indexer

Storage for each additional ISIS system needs to be configured in a Media Indexer running on an 
AS3000 server. All Media Indexers need to be configured in one high-availability group (HAG). 
For more information, see “Configuring Media Indexer for Additional ISIS Systems” on 
page 108.
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ISIS Client Workspace Mounting

If you are working in a multiple ISIS environment, you must mount at least one workspace for 
each ISIS system to which you are connected. You can mount the workspace as a UNC drive or a 
lettered drive. This requirement applies to Avid editing systems, Interplay Assist, Avid Instinct, 
and any Interplay components that require connection to an ISIS system. On Avid editing 
systems, a lettered drive is required for write access to a workspace.

Adding Remote ISIS Systems to ISIS Client Software
After the local ISIS system is installed and configured, use the Avid ISIS Client Manager on the 
Interplay Engine to add a remote ISIS system.

To add a remote system:

1. Start the Avid ISIS Client Manager by clicking Start > All Programs > Avid > ISIS Client.

2. Click the Remote Host Settings button, as shown in the following illustration.

The Remote Hosts dialog box opens.
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3. Enter the hostname for the remote ISIS server and click the Add (+) button.

The ISIS server appears in the Host list.

4. Click the Apply button (green check mark) and close the dialog box.

The remote host is listed in the Systems list.
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Configuring Media Indexer for Additional ISIS 
Systems

One Media Indexer (MI) can index two or more ISIS systems in the same Interplay workgroup. 
The following limitations apply:

• Each MI in the High Availability Group (HAG) must have access to all available ISIS 
workspaces. For information on setting up and configuring ISIS systems, see the Avid 
Products and Network Site Preparation Guide and the Setup Guide for your ISIS product.

• Configure the ISIS client on the MI to recognize all available ISIS systems. Use the ISIS 
Client Manager to connect to additional ISIS systems, as described in “Adding Remote ISIS 
Systems to ISIS Client Software” on page 106.

• Configure the leader of the HAG to see all of the storage locations that you want to access on 
both ISIS systems, as described in “Configuring Media Indexer Servers and Clients” on 
page 51. For example, the following illustration shows connections to the workspaces on 
two ISIS systems. The two System Directors are named A51-wg1-sd1 and BSI-Multi-ISIS.
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Adding Remote ISIS Systems in the Interplay 
Administrator

If your workgroup is configured for Avid Unity Authentication, you need to specify each 
additional ISIS server name in the User Authentication Providers view of the Interplay 
Administrator. Users can then use their Avid ISIS credentials to log in to the Interplay database 
and access any additional ISIS servers to which they have access.

For more information, see Setting Avid ISIS Authentication.

n If you list ISIS server names for Unity authentication, the servers that you specify determine 
which workspaces are available in the Media Creation Workspace setting.This occurs whether or 
not ISIS user authentication is activated. See “Media Creation Workspaces” on page 103.
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To configure additional shared-storage systems for Unity Authentication in the Interplay 
Administrator:

1. In the User Management section of the Interplay Administrator window, click the User 
Authentication Providers icon.

The User Authentication Providers view opens.

2. Click Avid ISIS Authentication.

3. Click the Add Avid ISIS button.

4. Type the System Director hostname for the additional Avid ISIS systems.

Click the Remove Entry button to delete a hostname.

The name that you type depends on the configuration of the ISIS system.

- For a configuration with a single System Director, type the System Director hostname 
that is set in the ISIS Control Panel in the System Director.

- For a configuration with two System Directors (dual System Director configuration), 
type the Virtual System Director hostname that is set in the Control Panel for both 
System Directors. The Virtual System Director Name represents the two virtual IP 
addresses that you also set in the ISIS Control Panel. 

The name you type must match the ISIS name that appears in the ISIS Client Manager that is 
running on the Interplay Engine. For more information, see the Setup Guide for your ISIS 
system.

5. Click Apply.

The first time an Avid ISIS user logs into Interplay, the user is added to the Central 
Configuration Server (CCS) as part of the UNITY user group under Imported Users, with 
Read rights by default.
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n In the Server Hostname Settings view of the Interplay Administrator, there is a setting for 
Fallback Shared-Storage Server. In most cases the name of the local ISIS system is entered 
automatically. If you need to manually enter the computer name, use the name of the System 
Director for the local ISIS system. 

Mounting ISIS Workspaces as UNC Paths
A multiple ISIS configuration is likely to have a large number of workspaces. Mounting 
workspaces as UNC paths provides the ability to mount more drives than the number of drive 
letters available. 

Starting with version 2.6, the Interplay Transcode service and the STP Encode service require 
you to choose how ISIS workspaces are mounted: by drive letter or by UNC path. For multiple 
ISIS workgroups, select UNC path. After installation, configure the ISIS Client Manager to use 
UNC paths.

Working with Media Services and Interplay Transfer 
in a Multiple ISIS Workgroup

Most Media Services and Interplay Transfer profiles include a setting for shared-storage 
workspaces. If you are adding remote ISIS systems to an existing workgroup, your existing 
profiles will work correctly with the workspaces as they are currently defined. The following 
sections supply information about creating new profiles.

Move v2.6 and Later and Other Media Services

Interplay Move v2.6 and later supports high-speed transfer of media between multiple ISIS 
systems. A 10-GB network is recommended. Existing profiles will work correctly with the 
workspaces as currently defined. For a new or edited profile that specifies a workspace on a 
remote ISIS system, the workspace path must include the hostname of the ISIS System Director 
and the name of the workspace, in the standard UNC format:

\\hostname\workspace_name

The following illustration shows an example, in which a51-wg1-sd1 is the System Director for 
the target ISIS system, and Highest_Copy is the target workspace.
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For more information, see “Working with the Move Service” in the Interplay | Media Services 
Setup and User’s Guide.

Use the same format for workspaces in other Media Services profiles, such as Delivery and 
Transcode when the target workgroup includes multiple ISIS systems. Existing profiles will 
work correctly with the workspaces as currently defined, but new or edited profiles that specify a 
workspace on a remote ISIS system must include the hostname of the ISIS System Director.

Interplay Transfer v2.6 and Later

Interplay Transfer uses an ISIS workspace for incoming transfers. For easier workspace 
management, you should include the System Director hostname in a UNC path in the “No-login 
workspace for incoming transfers” setting in the Avid Interplay Transfer Engine Configuration 
dialog box.



A SR2500 Slot Locations

The Intel® SR2500 is supported as a server for the Interplay applications. This section shows the 
front and back view and describes the slot locations that are specific to the Interplay components.

• SR2500 Front View

• SR2500 Slot Locations
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SR2500 Front View

The following illustration shows the front view and control panel.

The following table describes the control panel shown in the previous figure.

Control panel

DVD/CD-ROM

RAID disk (ID 1)

System disk (ID 0)

A

B
C D E F

G

H

I

JL K

SR2400 and SR2500 Front View

System Director Control Panel

Letter Description Letter Description

A Power/Sleep button G System ID LED (blue, a second system 
ID LED is on the rear)

B NIC 2 activity LED H System ID button (System ID LED 
blinks when pressed)

C NIC 1 activity LED I System reset button

D Power/Sleep LED J USB 2.0 connector

E System status LED K Recessed NMI button (need tool)

F Internal drive activity LED L Video connector
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SR2500 Slot Locations

The SR2500 is supported as a server for the Interplay applications. This section describes the slot 
locations that are specific to the Interplay components.

Use the following figure and tables as guides to how your SR2500 is configured in an Interplay 
environment. 

n It’s important to match the slot locations in the following tables because they match the order 
that the drivers are loaded on the SR2500 Recovery DVDs.

SR2500 Back Panel Configuration Options for Avid ISIS

Slot Type Slot 
Interplay Engine and othera 
Interplay servers

a. Includes servers for Interplay Archive Engine, Interplay Media Indexer, Interplay Media Services, 
Transcode Providers, and General Purpose Server.

Interplay Transfer and 
Archive Providers

PCI-X  3 Empty PRO/1000 XF/MFb

b. Install PRO/1000 MF or XF as optical options for use with Interplay Transfer.

2 Empty Emulex 1050c 

c. Install Emulex 1050 for use with Interplay Transfer/Profile.

1 Empty Empty

PCIe 3 Empty Empty

2 Empty PRO/1000 PTd

d. Optional replacement for Intel PRO/1000 MF or XF.

Empty Empty

Slot 3

Slot 2

Slot 1

Slot 3

Slot 2

Slot 1

PCI-X slotsPCIe slots
SR2500 Back Panel

Primary power 
supply on bottomSerial A to F/C switch if needed

Keyboard
RJ 45 to 
serial B

1 Gig 
Enet

Video

USB

1 2

Mouse

Power supplies
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n  For slot locations on the Interplay Streaming server, see “Streaming Server Slot Locations, 
SR2500” on page 110.



B Configuring the Copy Provider Server

This chapter describes how to set up the hardware and ISIS client information on a Copy 
Provider server. The following topics are described:

• Copy Provider Configuration on an AS3000

• ISIS Connections and Client Software Installation

• Creating Copy Provider User Accounts for ISIS and Interplay

Running the Copy Provider on an SR2500 System

Starting at Interplay v2.7, the Copy Provider and Move Provider are 64-bit applications and must 
be run on Windows 7 Pro 64-bit. This means that SR2500 systems running a 32-bit OS must be 
upgraded to the 64-bit OS. A 64-bit Windows 7 Pro image is available for the SR2500 and a 
minimum of 4 GB of RAM is recommended. The Myricom cards are supported on this upgraded 
system. Note that it is the responsibility of the customer to source the Microsoft WIN7 64-bit 
license for the image. See your Avid representative for additional information.

Copy Provider Configuration on an AS3000

The Copy Provider on an AS3000 uses two Myricom PCIe cards. The following illustration 
shows the rear view of the AS3000.

The AS3000 has two PCIe slots and they both support the Myricom cards. The appropriate 
drivers are pre-loaded onto the AS3000 images for Windows 7 Pro 64-bit.

1 2

3 4

Two PCIe slotsPRO/1000 PT ports
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To install the Myricom cards:

1. Install the cards in the two PCIe slots as described in the AS3000 Setup Guide.

2. Reconnect and restart the system. 

The system automatically recognizes the Myricom cards because the drivers are pre-loaded 
on the Windows 7 Pro 64-bit image. 

If you find it necessary to locate the Myricom drivers, the Myricom drivers folder is located 
in the following location:

C:\Installables\drivers\nic

The following illustration shows the Myricom entries in the Windows Device Manager.
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ISIS Connections and Client Software Installation

The following illustration shows the basic workflow for copying metadata and media files. The 
Copy Provider copies metadata from one Interplay Engine to another, and copies media files 
from one ISIS shared storage system to another. This example shows a configuration that is used 
for copying media in either direction (from Workgroup 1 to Workgroup 2, or from Workgroup 2 
to Workgroup 1), so a Media Services Engine and Copy Provider are required in each 
workgroup.

Each Copy Provider must be directly connected to both ISIS systems.

When directly connecting the 10-Gb Ethernet fibre adapter board into the ISS 10-Gb port on the 
Avid ISIS Engine, each link between the two workgroups must be within the maximum distance 
shown in the following table.

Avid 
Editing
System

Interplay
Access

Interplay
Engine

Avid 
Editing
System

Interplay
Access

Interplay
Engine

Media
Services
Engine

Copy 
Provider

ISIS
Storage

Interplay Workgroup 1 Interplay Workgroup 2

Media

Metadata

The Copy Provider copies
metadata to the Interplay Engine 
and media files to ISIS storage.

Media
Services
Engine

Copy 
Provider

ISIS
Storage

From Workgroup 1 to Workgroup 2

From Workgroup 2 to Workgroup 1

Metadata

Media
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As a result, the distance between two workgroups can be twice the maximum cable length.

For more information on cabling for Avid ISIS, see the Avid Products and Network Site 
Preparation Guide. If you want to copy media to another workgroup when the workgroups are 
located beyond the maximum cable length, you must use Interplay Transfer.

Making the ISIS Connections on an AS3000

This topic describes two different kinds of network connections. For more information on 
cabling for Avid ISIS, see the Avid Products and Network Site Preparation Guide.

c For best performance, do not connect two Copy Providers to the same ISIS chassis. If you 
have more than one Copy Provider, connect each to a different ISIS chassis.

Using the Myricom Cards

When using the Myricom cards, connect the Myricom cards directly into the ISS 10-Gb ports on 
the Avid ISIS Engines. Connect the Copy Provider to both Avid ISIS systems.

The following illustration shows the Myricom connections to two different ISIS systems named 
Big ISIS and WG6.

10-Gb Cable (MMF 50 micron cable)
Maximum Cable Length 
(Copy Provider to ISIS)

500 MHz*km (Overfilled Launch Bandwidth, typical of OM2 cable) 82 m

2000 MHz*km (Effective Modal Bandwidth, typical of OM3 cable) 300 m

4700 MHz*km (Effective Modal Bandwidth, typical of OM4 cable) 550 m

ISIS #1 ISIS #2
Copy
Provider

Max 300m
   (OM3)

Max 300m
   (OM3)

Max 600m
   (OM3)
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n Unused network connections are disabled in the above illustration. This not required and 
depends on your site policies. Some sites disable all unused NICs.

Using the 1Gb Onboad NICs on the Copy Provider

When using the 1 Gb onboard NIC on the Copy Provider, connect the Pro/1000 PT ports labeled 
2 and 4 on the Copy Provider directly into any 1 Gb port on the Avid ISIS Engines. Connect the 
Copy Provider to both Avid ISIS systems. Avid does not recommend using the onboard NICs 
because performance is better using the Myricom cards.

n The silkscreen labels on the back of the AS3000 identify the Pro/1000 PT ports as 2 and 4. When 
you look at the ports in the Network Connections software interface, the two ports are listed as 2 
and 3. The above illustration shows how the ports are listed via the Network Connections 
interface. When you make the physical connection, use the ports labeled 2 and 4 on the back of 
the AS3000.

Copy Provider ISIS Configurations

Each ISIS Engine (also known as an ISIS chassis) supports a maximum of two Copy Providers:

• One for sending material to a remote workgroup

• One for receiving material from a remote workgroup

If you have multiple ISIS chassis in your workgroup, you can set up multiple sending and 
receiving providers. 
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The following illustration shows Copy Providers configured between two workgroups.

Copy Provider and ISIS Versions

The ISIS systems must be running compatible versions of ISIS software. For compatibility 
information, see the Interplay ReadMe.

Installing the ISIS Client Software

This section describes how to install the ISIS client software.

To install the ISIS Client software:

t Use the Avid ISIS installer DVD to install the ISIS client software. 

The Avid ISIS System Quick Start Card, located in the top-level Avid ISIS Documentation 
folder on the Avid ISIS installer DVD, contains instructions for installing Avid ISIS client 
software. See the ISIS ReadMe for additional information about installing the client 
software on your system.

Chassis 1

Chassis 2

Copy
Providers

Chassis 1

Workgroup A Workgroup B

ISIS ISIS

Chassis 2

Chassis 1

Copy
Providers

Chassis 1

Workgroup A Workgroup B

ISIS ISIS

Chassis 2 Chassis 2

Example 1 One send and one receive can use a single chassis on each workgroup

Example 2 Two simultaneous sends requires two chassis.
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Creating Copy Provider User Accounts for ISIS and 
Interplay

Both ISIS systems and both Interplay workgroups must include matching user accounts as 
follows: 

• Both ISIS systems and both Interplay workgroups must include matching user accounts. The 
user name and password for these accounts must match exactly. 

- The ISIS user account must have read/write privileges on the workspaces you want to 
copy from and copy to.

- The Interplay user account must have read/write privileges on the folders you want to 
copy from and copy to.

The following table summarizes the locations where you must create matching accounts and 
where they are used. 

Avid recommends that you use the same Central Configuration Server (CCS) for both 
workgroups to make user management easier. For more information on the CCS, see the 
Interplay | Engine and Interplay | Archive Engine Administration Guide.

• You must connect the Copy Provider to both ISIS systems through the same account. The 
workspaces must be mounted using letterless drive mappings. 

Account Where used

ISIS user in Workgroup A

ISIS user in Workgroup B

ISIS Client Manager on Copy Provider

Interplay user in Workgroup A

Interplay user in Workgroup B

Interplay Access on Interplay Engine
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The following illustration shows the ISIS Client Manager with Composer1 connected to two 
different workgroups.



C Configuring the Move Provider Server

This chapter describes how to set up the hardware and ISIS client information on a Move 
Provider server. The Move provider is used to move files from one ISIS workspace to another.

n The Move feature works only within a single workgroup with a single ISIS System Director. To 
copy assets and media to a different workgroup, use the Copy Provider.

The following topics are described:

• Move Provider Configuration on an AS3000

• ISIS Connections and Client Software Installation

• Creating Move Provider User Accounts for ISIS and Interplay

For details on setting up and using the Move Provider, see the Interplay | Media Services Setup 
and User’s Guide and the Interplay | Access User’s Guide.

For information about configuring the AS3000, see the AS3000 Setup Guide.

Running the Copy Provider on an SR2500 System

Starting at Interplay v2.7, the Copy Provider and Move Provider are 64-bit applications and must 
be run on Windows 7 Pro 64-bit. This means that SR2500 systems running a 32-bit OS must be 
upgraded to the 64-bit OS. A 64-bit Windows 7 Pro image is available for the SR2500 and a 
minimum of 4 GB of RAM is recommended. The Myricom cards are supported on this upgraded 
system. Note that it is the responsibility of the customer to source the Microsoft WIN7 64-bit 
license for the image. See your Avid representative for additional information.
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Move Provider Configuration on an AS3000

This topic describes how to set up the hardware for a Move Provider on an AS3000 server.

The AS3000 has two PCIe slots and both support the Myricom cards. The appropriate drivers are 
pre-loaded onto the AS3000 image for Windows 7 Pro 64-bit. The Move Provider only requires 
one Myricom card. You can install it in either slot.

To install the Myricom card:

1. Install the card in the either of the two PCIe slots as described in the AS3000 Setup Guide. 
For convenience, use the bottom slot.

2. Reconnect and restart the system. The system automatically recognizes the Myricom card 
because the drivers are pre installed on the Windows 7 Pro recovery image.

For an illustration shows that shows the Myricom card in the Windows Device Manager, see 
“Copy Provider Configuration on an AS3000” on page 117.

If you find it necessary to locate the Myricom drivers, the Myricom drivers folder is located 
in the following location:

C:\Installables\drivers\nic

Using a 1Gb Onboard NIC on the Move Provider

When using a 1 Gb onboard NIC on the Move Provider, connect one of the Pro/1000 PT ports 
labeled 2 or 4 on the Move Provider directly into any 1 Gb port on the Avid ISIS Engines. Avid 
does not recommend using the onboard NICs because performance is better using the Myricom 
cards.

1 2

3 4

Two PCIe slotsPRO/1000 PT ports
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ISIS Connections and Client Software Installation

The Move Provider must be directly connected to the ISIS system, using a 10 Gb Ethernet 
connection. For more information on cabling for Avid ISIS, see the Avid Products and Network 
Site Preparation Guide. 

To make the ISIS connections on an AS3000:

t Connect the Myricom card directly into the ISS 10-Gb port on the Avid ISIS Engine.

To install the ISIS Client software:

t Use the Avid ISIS installer DVD to install the ISIS client software. 

The Avid ISIS System Quick Start Card, located in the top-level Avid ISIS Documentation 
folder on the Avid ISIS installer DVD, contains instructions for installing Avid ISIS client 
software. See the ISIS ReadMe for additional information about installing the client 
software on your system.

Creating Move Provider User Accounts for ISIS and 
Interplay

The following accounts are required for the Move operation: 

• The ISIS user account must have read/write privileges on the workspaces you want to move 
from and move to.

• The Interplay user account must have read/write privileges on the folders you want to move 
from and move to.

For additional information on creating accounts, see the Avid ISIS Administration Guide and the 
Interplay | Engine and Interplay | Archive Engine Administration Guide.



D Installing Cards on the Interplay Transfer 
Server

This chapter covers the following topics:

• Interplay Transfer Server Slot Locations and Network Connections

• Installing Cards in the Interplay Transfer Server

Interplay Transfer Server Slot Locations and Network 
Connections

For information on Interplay Transfer slot locations, see “SR2500 Slot Locations” on page 113.

The following illustration shows the rear view of an AS3000 server.

The Interplay Transfer server runs Windows 7 Pro 64 Bit. The server does not require any PCIe 
cards. For more information about the AS3000, see the Avid AS3000 Setup Guide.

1 2

3 4

PRO/1000 PT Ports

AS3000 Back Panel

PCIe Slots
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ISIS and Network Connections

The following table shows the connections for ISIS 5000 and ISIS 7000.

External devices should communicate with the Interplay Transfer engine via the DNS entry of 
the network connection.

Port Usage on the Interplay Transfer Server

For two workgroups to cooperate, some workstations in one workgroup must have access to 
services in the other workgroup. If these workgroups are not in the same site, or are separated by 
routers or firewalls, you have to establish access to allow these services to work together.

The main components are an Avid Interplay Engine and two Interplay Transfers. All these 
services are TCP/IP based.

• The Avid Interplay Engine leverages the standard HTTP service on port 80. 

• The Interplay Transfers use port numbers that are defined in the services file in 
\WINDOWS\SYSTEM32\DRIVERS\ETC\. As installed, these port numbers are as follows:

- 6532 - the Interplay Transfer Engine listens on this port for requests from other TM 
servers (for example, initiating a workgroup transfer).

- 6535 - This is the default port used by the Interplay Transfer Engine for connecting to 
playback servers (for example, AirSpeed Multi Stream).

- 6539 - The Interplay Transfer Engine listens on this port for incoming requests from the 
Transfer Client.

Interplay Transfer uses ports 6432 and 6535 to communicate with the sending or receiving 
device. After the Transfer Engine establishes the connection, the OS on the external device 
assigns a port and notifies the Transfer Engine of the new port number. Then the external device 
starts listening on that port. Transfer Engine uses the new port number for sending or receiving 
data.

Connection Type ISIS 5000 ISIS 7000

First ISIS connection Pro/1000 PT Port Pro/1000 PT Port

Second ISIS connection NA Pro/1000 PT Port

Network connection Pro/1000 PT Port Port 1 or 3. If you have only one ISIS 
connection, use the second Pro/1000 PT Port 
for the network connection.
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Installing Cards in the Interplay Transfer Server

For information about configuring the AS3000, see Migrating Interplay Applications to AS3000 
Servers.

The cards included with the Interplay Transfer server depend on the Avid shared storage 
environment where the Interplay Transfer server is being installed.

In an Avid ISIS environment, the Interplay Transfer server might ship with an Intel® PRO/1000 
Server Adapter gigabit card, depending on your system’s configuration. This card must be 
installed in slot 3 (top slot). Follow the directions supplied with the card. For information on 
configuring the Intel PRO/1000 card, see “Configuring the Intel PRO/1000 Adapter Card” on 
page 130. 

Configuring the Intel PRO/1000 Adapter Card

For information about configuring the AS3000, see Migrating Interplay Applications to AS3000 
Servers.

The Intel PRO/Adapter card might require the installation of the Intel Pro/1000 driver. After you 
install the driver, you need to configure the card to work correctly with the Interplay Transfer 
server. This section provides procedures for installing the driver and configuring the card for 
Jumbo Frames.

To install the Intel PRO/1000 driver:

1. Install the Intel PRO/1000 server adapter card and restart your system.

A message might appear, looking for the Intel PRO/1000 driver. 

2. Open the C:\IntelPro folder.

3. Click the Autorun.exe file.

The Intel Pro Network Connections window opens.

4. Click Install Drivers.

5. Click Finish.

To configure the Intel PRO/1000 card for Jumbo Frames:

1. Right-click the My Network Places icon, and select Properties.

2. Right-click the file for the Intel Pro interface used by Interplay Transfer and select 
Properties.

3. Click Configure.

4. Click the Advanced tab.
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5. In the Property area, select Jumbo Frames.

6. In the Value area, select 9014Bytes.

7. Click OK.



E Interplay | Production Port Usage

The table in this section list networks ports used by Interplay. It does not include ports used by 
ISIS shared storage. This information is useful to network administrators when configuring the 
network and firewalls, setting up ISIS Zone 3 clients, and resolving network conflicts.

n If you are transferring material between different sites, you must open port 80 on the Firewall of 
the receiving site in order to allow communication with the Interplay Engine. This is required for 
Interplay Delivery and Media Composer Cloud. 

Also refer to the following documents:

• For port usage on Media Composer Cloud, see the Media Composer Cloud Network 
Information and Port Usage on the Avid Knowledge Base.

• For port usage on MediaCentral, see Interplay MediaCentral Security Architecture and 
Analysis on the Avid Knowledge Base.

Interplay Production Port 
Usage

Component and Location Port Protocol Purpose

Access 8321 UDP Server Browser.

80 TCP Server communication.

Access can also be a Media Indexer client 
(update media status, Resync), Media 
Services client (status tool plugin and submit 
jobs to archive and Transcode), and Transfer 
Engine client (status tool plugin, initiate 
WG2WG transfers); see appropriate 
sections.

Active Directory 135 TCP RPC for Active Directory / Windows 
Domain Authentication.

Archive Provider 1433 TCP #Microsoft-SQL-Server (ms-sql-s).
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These values are for SGL 
connections. For other third 
party archive solutions, see the 
third party documentation.

1433 UDP #Microsoft-SQL-Server (ms-sql-s).

1434 TCP #Microsoft-SQL-Monitor (ms-sql-m).

1434 UDP #Microsoft-SQL-Monitor (ms-sql-m).

8192 TCP #FlashNetBackupClient (sdss).

Assist Assist uses Access ports for Interplay engine 
communication. It is also a Media Indexer 
client. See appropriate sections for port 
usage.

Cluster Service 135 TCP RP; also used by Distributed Link Tracking 
Server - Service Name TrkSvr and 
Distributed Transaction Coordinator - 
Service Name MSDTC).

Random TCP Randomly allocated high TCP ports; also 
used by Distributed Link Tracking Server - 
Service Name TrkSvr and Distributed 
Transaction Coordinator - Service Name 
MSDTC).

3343 UDP Cluster Services (service name: ClusSvc).

Delivery Receiver 80 TCP Communication with Interplay Engine.

33321  TCP Command port. Also identified in the 
Interplay Administration tool under Server 
Hostname Settings. You can change the port 
number in the Interplay Administration tool.

20020-2102
0

TCP Data ports. To change the default port 
numbers or select a smaller number of ports, 
see the Media Services Setup and User’s 
Guide. You only need one port for each 
active delivery job.

Interplay Production Port 
Usage (Continued)

Component and Location Port Protocol Purpose
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58889 TCP Web Services used by Media Composer 
Cloud. The Web Services implementation 
used by Media Composer Cloud is 
automatically installed on the Delivery 
Receiver system when you check the 
Delivery Receiver with Media Composer 
Cloud option.

7 TCP Ini server verification.

DNS 53 UDP/TCP DNS communication.

ICPS server 80 TCP Communication with the ICPS playback 
service

5000 TCP Serving outbound JPEG images to Flash 
player and Media Composer Cloud clients

26000 TCP Inbound ICPS data

843 TCP Loading the Flash player for playback

443 TCP HTTPS communication

iNews 21 FTP FTP into iNEWS database: Teleprompters, 
NewsCutter newsroom system tool, Data 
Receiver.

22 SSH ssh.

25 sendmail.

67 Used by PCU's to obtain an IP address via 
bootp.

80 http Web Access, for read-only database 
access.

513 rlogin.

600 FTP into Linux partition.

698 Might be required for Web access through 
cgi-bin.

Interplay Production Port 
Usage (Continued)

Component and Location Port Protocol Purpose
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699 Used by dbvisit (maintenance program) for 
on-line dbvisits.

1019 Server listens for client connections.

1020 Server updates/notifications to client, 
specified by client. Each client running on a 
machine must bind to a unique socket. If a 
user intends to run N sessions of iNEWS on 
the same machine, then ports 1020 through 
1020 + (N-1) must be opened in the firewall 
(TCP and UDP).

1022 iNEWS bioserver communication.  More 
often used on 2-server systems, but might 
use loopback.

1023 Used by connect command during startup.

5901 First remote access port for VNC to Linux 
UI, might have more than one VNC session 
configured (5902, 5903, and so on).

6100 FTS indexing (configurable).

6101 FTS searching (configurable).

6825 Monitor, for ControlAir.

6826 Monitor for MOS.

49152 TELNET Telnet.

Instinct Instinct uses Access ports for Interplay 
engine communication. It is also a Media 
Indexer client. Instinct E3is also an iNEWS 
client. See appropriate sections for port 
usage. 

Interplay Engine 8321 UDP Server Browser.

80 TCP Client communication.

& TCP Jini server verification for Remote Upload.

Interplay Streaming Server 554 TCP Direct client/server communications. 

Interplay Production Port 
Usage (Continued)

Component and Location Port Protocol Purpose
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UDP For UDP packets, any firewall between 
Access clients and the streaming server must 
be configured either to allow RTSP/RTP 
traffic or to allow UDP packets between 
clients and server. The UDP streaming 
traffic uses dynamic random ports and not a 
fixed port range.

If UDP packets are lost on the way from the 
server to the client there is no direct 
feedback. The Streaming Server does not get 
any feedback that the packets were lost, and 
the Access client must wait until a timeout 
occurs.

Media Indexer 61616 TCP Connection to the Media Indexer server

6155 TCP Communication between Media Indexer 
servers in the HAG

8888 - 8892 TCP Connection to the Media Indexer web 
interface. The web user interface uses the 
first available port starting with 8888 and 
going through 8892.

24444 TCP Used to connect the monitoring tool 
provided by the java jdk, called jconsole.

The Media Indexer also requires Avid 
Service Framework port connections.

Service Framework Ports are dynamic and services register 
themselves with firewall to use any port.

dynamic (0 - 
1024)

TCP Codebase http server. 

dynamic TCP Jini™ ERI ServerConnectionManager.

dynamic - 
above 1024

TCP Jini ERI ConnectionManager.

dynamic TCP/ UDP TCP/UDP notifications.

4160 TCP Jini Discovery.

Interplay Production Port 
Usage (Continued)

Component and Location Port Protocol Purpose
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4160 UDP Jini Discovery.

LDAP 389 TCP

636 If SSL is enabled.

Media Services Engine 8080 TCP Listen for editor clients (SOAP).

1099 TCP Listen; RMI protocol for providers and 
Status/Admin tool.

42000-4206
0

TCP If 1099 not available. 

Media Services Providers / 
Status Tool

1099 TCP Outbound; RMI protocol for providers and 
Status/Admin tool.

42000-4206
0

TCP If 1099 not available. 

Media Composer and 
NewsCutter

21 TCP Required for NewsCutter NRCS tool.

8080 TCP Outbound; Media Services connection to 
Media Services Engine (SOAP).

Media Composer and NewsCutter use 
Access ports for Engine communication. 
They also run the Service Framework and a 
local Media Indexer; see appropriate 
sections for port usage.

58000 TCP HTTP communication with the Background 
Transcode broker.

Background Transcode on the 
editor system

58001 TCP Communication between Background 
Transcode broker and other clients.

8888 TCP Connection to the Media Indexer web 
interface

8185 TCP Background Transcode status

8185 TCP Background Transcode status

Interplay Production Port 
Usage (Continued)

Component and Location Port Protocol Purpose
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Dynamic Media Folders (DMF) 
on the editor system

58885 TCP Local communication with the DMF service.

58886 TCP Local communication with the DMF support 
service on a Mac OS X system.

Transfer Cache 1099 TCP Listen: RMI protocol for providers and 
Status/Admin tool.

42000-4206
0

TCP If 1099 not available. 

6539 TCP Outbound for Transfer Engine status.

Transfer Engine 6532 TCP/IP Media Connectivity tool (defined in 
system32\drivers\etc\services 
com.avid.mct). The TM server listens on this 
port for requests from other TM servers (for 
example, initiating a workgroup transfer.).

6535 TCP/IP Playback protocol (defined in 
system32\drivers\etc\services 
com.avid.pbp). This is the default port used 
by TM Server for connecting to Playback 
Servers (Airspace etc.). This is configurable 
for some playback servers.

6539 TCP/IP Transfer Engine (defined in 
system32\drivers\etc\services com.avid.pbp 
com.avid.xmgr). The TM Server listens on 
this port for incoming requests from the TM 
Client.

Web Services 80 TCP Communication with Interplay Engine.

Also see Delivery Receiver for information 
on Web Services for Media Composer Cloud 
option.

Interplay Production Port 
Usage (Continued)

Component and Location Port Protocol Purpose
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